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Introduction

This manual contains detailed instructions and notes on the operation and use of this machine. For your

safety and benefit, read this manual carefully before using the machine. Keep this manual in a handy

place for quick reference.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-

able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-

ating the machine.

Software Version Conventions Used in This Manual

• NetWare 3.x means NetWare 3.12 and 3.2.

• NetWare 4.x means NetWare 4.1, 4.11, 4.2 and IntranetWare.
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Manuals for This Machine

Refer to the manuals that are relevant to what you want to do with the machine.

Important

❒ Media differ according to manual. 

❒ The printed and electronic versions of a manual have the same contents.

❒ Adobe Acrobat Reader/Adobe Reader must be installed in order to view the
manuals as PDF files.

❒ Depending on which country you are in, there may also be html manuals. To
view these manuals, a Web browser must be installed.

❖ About This Machine
Be sure to read the Safety Information in this manual before using the ma-
chine.
This manual provides an introduction to the functions of the machine. It also
explains the control panel, preparation procedures for using the machine,
how to enter text, and how to install the CD-ROMs provided.

❖ General Settings Guide
Explains User Tools settings, and Address Book procedures such as register-
ing fax numbers, e-mail addresses, and user codes. Also refer to this manual
for explanations on how to connect the machine.

❖ Trouble Shooting
Provides a guide to solving common problems, and explains how to replace
paper, toner, and other consumables.

❖ Security Reference
This manual is for administrators of the machine. It explains security func-
tions that the administrators can use to protect data from being tampered, or
prevent the machine from unauthorized use.
Also refer to this manual for the procedures for registering administrators, as
well as setting user and administrator authentication.

❖ Copy/Document Server Reference
Explains Copier and Document Server functions and operations. Also refer to
this manual for explanations on how to place originals.

❖ Facsimile Reference
Explains Facsimile functions and operations.

❖ Printer Reference
Explains Printer functions and operations.

❖ Scanner Reference
Explains Scanner functions and operations.
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❖ Network Guide
Explains how to configure and operate the machine in a network environ-
ment, and use the software provided. This manual covers all models, and in-
cludes descriptions of functions and settings that might not be available on
this machine. Images, illustrations, and information about operating systems
that are supported might also differ slightly from those of this machine.

❖ Other manuals

• Manuals for This Machine

•  Safety Information

• Quick Reference Copy Guide

•  Quick Reference Fax Guide

• Quick Reference Printer Guide

• Quick Reference Scanner Guide

• PostScript 3 Supplement

• UNIX Supplement

• Manuals for DeskTopBinder Lite

• DeskTopBinder Lite Setup Guide

• DeskTopBinder Introduction Guide

• Auto Document Link Guide

Note

❒ Manuals provided are specific to machine types.

❒ For “UNIX Supplement”, please visit our Web site or consult an authorized
dealer.

❒ “PostScript3 Supplement” and “UNIX Supplement” include descriptions of
functions and set not be available on this machine.

❒ Adobe Acrobat Reader/Adobe Reader must be installed in order to view the
manuals as PDF files.
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How to Read This Manual

Symbols

This manual uses the following symbols:

Indicates important safety notes.

Ignoring these notes could result in serious injury or death. Be sure to read these
notes. They can be found in the “Safety Information” section of About This Ma-
chine.

Indicates important safety notes.

Ignoring these notes could result in moderate or minor injury, or damage to the
machine or to property. Be sure to read these notes. They can be found in the
“Safety Information” section of About This Machine.

Indicates points to pay attention to when using the machine, and explanations
of likely causes of paper misfeeds, damage to originals, or loss of data. Be sure
to read these explanations.

Indicates supplementary explanations of the machine’s functions, and instruc-
tions on resolving user errors.

This symbol is located at the end of sections. It indicates where you can find fur-
ther relevant information.

[ ]

Indicates the names of keys that appear on the machine’s display panel.

{ }

Indicates the names of keys on the machine’s control panel.
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Setting Up the Machine on a Network

This section describes the network settings you can change with User Tools (Sys-
tem Settings). Make settings according to functions you want to use and the in-
terface to be connected.

Important

❒ These settings should be made by the systems administrator, or after consult-
ing with the systems administrator.

❖ Viewing the Information Displayed in the List
$ These items must be set to use the function. Be sure to set them before at-
tempting to use the corresponding function.

 These items must be set if required.

Printer/LAN-Fax

Interface Settings

Ethernet Interface Set-
tings/Network

IP Address $

Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol *2 $

NCP Delivery Proto-
col

NW Frame Type

SMB Computer Name

SMB Work Group

Ethernet Speed

LAN Type *1 $

Ping Command

Permit SNMP V3 
Communication

Permit SSL / TLS 
Communication

Host Name

Machine Name
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*1 Appears when the optional IEEE 802.11b interface unit is installed.
If Ethernet and IEEE 802.11b (wireless LAN) are both connected to the machine, the
selected interface has priority.

*2 Check [Effective] is selected for TCP/IP.

IEEE 802.11b (wire-
less LAN)

Interface Set-
tings/Network

IP Address $

Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol *2 $

NCP Delivery Proto-
col

NW Frame Type

SMB Computer Name

SMB Work Group

Ethernet Speed

LAN Type *1 $

Permit SNMP V3 
Communication

Permit SSL / TLS 
Communication

Host Name

Machine Name

Interface Set-

tings/IEEE 802.11b *1 

Communication 
Mode

$

SSID Setting

Channel

WEP (Encryption) 
Setting

Transmission Speed

Interface Settings
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Internet Fax

Interface Settings

Ethernet Interface Set-
tings/Network

IP Address $

Gateway Address $

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol *4 $

NCP Delivery Proto-
col

Ethernet Speed

LAN Type *1 $

Permit SNMP V3 
Communication

Permit SSL / TLS 
Communication

Host Name

File Transfer SMTP Server *2 $

SMTP Authentication

POP before SMTP

Reception Protocol *3 $

POP3 / IMAP4 Set-

tings *5 

Administrator's E-

mail Address *7 

E-mail Communica-

tion Port *3  *6 

$

E-mail Reception In-
terval

Max. Reception E-
mail Size

E-mail Storage in 
Server

Program / Change / 
Delete E-mail Mes-
sage

Program / Change / 
Delete Subject
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Ethernet File Transfer Fax E-mail Account *2  
*3 

$

Auto Specify Sender 
Name

IEEE 802.11b (wire-
less LAN)

Interface Set-
tings/Network

IP Address $

Gateway Address $

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol *4 $

NCP Delivery Proto-
col

Ethernet Speed

LAN Type *1 $

Permit SNMP V3 
Communication

Permit SSL / TLS 
Communication

Host Name

Interface Set-

tings/IEEE 802.11b *1 

Communication 
Mode

SSID Setting

Channel

WEP (Encryption) 
Setting

Transmission Speed

Interface Settings
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*1 Appears when the optional IEEE 802.11b interface unit is installed.
If Ethernet and 802.11b (wireless LAN) are both connected to the machine, the select-
ed interface has priority.

*2 Minimum settings required to use transmission.
*3 Minimum settings required to use reception.
*4 Check[Effective] is selected for TCP/IP.
*5 If you select [On] for [POP before SMTP], select this function also.
*6 If you select [On] for [POP before SMTP], check the port number for [POP3]. 
*7 If you select [On] for [SMTP Authentication], select this function also.

IEEE 802.11b (wire-
less LAN)

File Transfer SMTP Server *2 $

SMTP Authentication

POP before SMTP

Reception Protocol *3 $

POP3 / IMAP4 Set-

tings *5 

Administrator's E-

mail Address *7 

E-mail Communica-

tion Port *3  *6 

$

E-mail Reception In-
terval

Max. Reception E-
mail Size

E-mail Storage in 
Server

Program / Change / 
Delete E-mail Mes-
sage

Program / Change / 
Delete Subject

Fax E-mail Account *2  
*3 

$

Auto Specify Sender 
Name

Interface Settings
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E-mail

Interface Settings

Ethernet Interface Set-
tings/Network

IP Address $

Gateway Address $

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol *2 $

NCP Delivery Proto-
col

Ethernet Speed

LAN Type *1 $

Permit SNMP V3 
Communication

Permit SSL / TLS 
Communication

Host Name

File Transfer SMTP Server $

SMTP Authentication

POP before SMTP

POP3 / IMAP4 Set-

tings *3 

Administrator's E-
mail Address

E-mail Communica-

tion Port *4 

Program / Change / 
Delete E-mail Mes-
sage

Program / Change / 
Delete Subject

Scanner Recall Inter-
val Time 

Number of Scanner 
Recalls

Auto Specify Sender 
Name
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IEEE 802.11b (wire-
less LAN)

Interface Set-
tings/Network

IP Address $

Gateway Address $

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol *2 $

NCP Delivery Proto-
col

Ethernet Speed

LAN Type *1 $

Permit SNMP V3 
Communication

Permit SSL / TLS 
Communication

Host Name

Interface Set-

tings/IEEE 802.11b *1 

Communication 
Mode

SSID Setting

Channel

WEP (Encryption) 
Setting

Transmission Speed

Interface Settings



9

*1 Appears when the optional IEEE 802.11b interface unit is installed.
If Ethernet and 802.11b (wireless LAN) are both connected to the machine, the select-
ed interface has priority.

*2 Check [Effective] is selected for TCP/IP.
*3 If you select [On] for [POP before SMTP], select this function as well.
*4 If you select [On] for [POP before SMTP], check the port number for [POP3]. 

IEEE 802.11b (wire-
less LAN)

File Transfer SMTP Server $

SMTP Authentication

POP before SMTP

Reception Protocol *3 

Administrator's E-
mail Address

E-mail Communica-

tion Port *4 

Program / Change / 
Delete E-mail Mes-
sage

Program / Change / 
Delete Subject

Scanner Recall Inter-
val Time 

Number of Scanner 
Recalls

Auto Specify Sender 
Name

Interface Settings
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Scan to Folder

Interface Settings

Ethernet Interface Set-
tings/Network

IP Address $

Gateway Address $

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol *2 $

NCP Delivery Proto-
col

Ethernet Speed

LAN Type *1 $

Permit SNMP V3 
Communication

Permit SSL / TLS 
Communication

Host Name

File Transfer Default User Name / 
Password (Send)

Scanner Recall Inter-
val Time 

Number of Scanner 
Recalls
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*1 Appears when the optional IEEE 802.11b interface unit is installed.
If Ethernet and IEEE 802.11b (wireless LAN) are both connected to the machine, the
selected interface has priority.

*2 Check [Effective] is selected for TCP/IP.

IEEE 802.11b (wire-
less LAN)

Interface Set-
tings/Network

IP Address $

Gateway Address $

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol *2 $

NCP Delivery Proto-
col

Ethernet Speed

LAN Type *1 $

Permit SNMP V3 
Communication

Permit SSL / TLS 
Communication

Host Name

Interface Set-

tings/IEEE 802.11b *1 

Communication 
Mode

$

SSID Setting

Channel

WEP (Encryption) 
Setting

Transmission Speed

File Transfer Default User Name / 
Password (Send)

Scanner Recall Inter-
val Time 

Number of Scanner 
Recalls

Interface Settings
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Network Delivery Scanner

Interface Settings

Ethernet Interface Set-
tings/Network

IP Address $

Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol *3 $

NCP Delivery Proto-
col

Ethernet Speed

LAN Type *1 $

Permit SNMP V3 
Communication

Permit SSL / TLS 
Communication

Host Name

File Transfer Delivery Option *2 

Fax RX File Transmis-
sion

Scanner Recall Inter-
val Time 

Number of Scanner 
Recalls
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*1 Appears when the optional IEEE 802.11b interface unit is installed.
If Ethernet and IEEE 802.11b (wireless LAN) are both connected to the machine, the
selected interface has priority.

*2 When delivery option is set to [On], make sure the IP address is set.
*3 Check [Effective] is selected for TCP/IP.

IEEE 802.11b (wire-
less LAN)

Interface Set-
tings/Network

IP Address $

Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol *3 $

NCP Delivery Proto-
col

Ethernet Speed

LAN Type *1 $

Permit SNMP V3 
Communication

Permit SSL / TLS 
Communication

Host Name

Interface Set-

tings/IEEE 802.11b *1 

Communication 
Mode

$

SSID Setting

Channel

WEP (Encryption) 
Setting

Transmission Speed

File Transfer Delivery Option *2 

Fax RX File Transmis-
sion

Scanner Recall Inter-
val Time 

Number of Scanner 
Recalls

Interface Settings
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Network TWAIN Scanner

Interface Settings

Ethernet Interface Set-
tings/Network

IP Address $

Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol *2 $

NCP Delivery Proto-
col

Ethernet Speed

LAN Type *1 $

Permit SNMP V3 
Communication

Permit SSL / TLS 
Communication

Host Name
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*1 Appears when the optional IEEE 802.11b interface unit is installed.
If Ethernet and 802.11b (wireless LAN) are both connected to the machine, the select-
ed interface has priority.

*2 Check [Effective] is selected for TCP/IP.

IEEE 802.11b (wire-
less LAN)

Interface Set-
tings/Network

IP Address $

Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol *2 $

NCP Delivery Proto-
col

Ethernet Speed

LAN Type *1 $

Permit SNMP V3 
Communication

Permit SSL / TLS 
Communication

Host Name

Interface Set-

tings/IEEE 802.11b *1 

Communication 
Mode

$

SSID Setting

Channel

WEP (Encryption) 
Setting

Transmission Speed

Interface Settings
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Document Server

Interface Settings

Ethernet Interface Set-
tings/Network

IP Address $

Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol *2 $

NCP Delivery Proto-
col

Ethernet Speed

LAN Type *1 $

Permit SNMP V3 
Communication

Permit SSL / TLS 
Communication

Host Name
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*1 Appears when the optional IEEE 802.11b interface unit is installed.
If Ethernet and IEEE 802.11b (wireless LAN) are both connected to the machine, the
selected interface has priority.

*2 Check [Effective] is selected for TCP/IP.

IEEE 802.11b (wire-
less LAN)

Interface Set-
tings/Network

IP Address $

Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol *2 $

NCP Delivery Proto-
col

Ethernet Speed

LAN Type *1 $

Permit SNMP V3 
Communication

Permit SSL / TLS 
Communication

Host Name

Interface Set-

tings/IEEE 802.11b *1 

Communication 
Mode

$

SSID Setting

Channel

WEP (Encryption) 
Setting

Transmission Speed

Interface Settings
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1. Using a Printer Server

Preparing Printer Server

This section explains how to configure the machine as a Windows network
printer. The machine is configured to enabling network clients to use it. When
the network printer is connected via SmartDeviceMonitor for Client, you can set
the printing notification function to notify clients of the results of their print jobs.

Important

❒ Under Windows 2000, Windows XP Professional, or Windows Server 2003, to
change printer properties in the [Printer] folder, you need Printer Manage-
ment access authentication; under Windows NT 4.0, Full Control access au-
thentication. Log on to the file server as an Administrator or member of the
PowerUsers group.

A Open the [Printers] window from the [Start] menu.

The [Printers] window appears.

Under Windows XP or Windows Server 2003, [Printer and Fax] window ap-
pears.

B Click the icon of the machine you want to use. On the [File] menu, click
[Properties]. The printer properties appear.

C On the [Sharing] tab, click [Shared this printer].

D To share the machine with users using a different version of Windows,
click [Additional Drivers...].

If you have installed an alternative driver by selecting [Shared this printer] dur-
ing the printer driver installation, this step can be ignored.

E Click [OK], and then close the printer properties.

Printing notification via SmartDeviceMonitor for Client

Follow the procedure below to configure the machine to use the printing notifi-
cation function of SmartDeviceMonitor for Client.

Setting the print server

Important

❒ Under Windows 2000, Windows XP Professional, or Windows Server 2003, to
change printer properties in the [Printer] folder, you need Printer Manage-
ment access authentication; under Windows NT 4.0, Full Control access au-
thentication. Log on to the file server as an Administrator or member of the
PowerUsers group.
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A From the [Start] button on the task bar, point to [Programs], point to [SmartDe-
viceMonitor for Client], and then click [Print Server Setting].

The print server setting dialog box appears.

B Select the [Notify client PCs of printout/data-transmission ] check box, and then
click [OK].

After print server setting is made, a dialog box appears. Confirm the dialog
box content, and click [OK].

Click [Cancel] to interrupt the procedure.

A dialog box appears for client setting. 

C Click [OK].

The print server setting is completed. Each client must be set to receive print
notification.

Note

❒ Current printing jobs restart from the beginning after the spooler pauses
briefly.

❒ When the expansion function is not used, the function is automatically set
as available.

❒ If you log on using an account that does not have Administrator privileges,
the client may not be notified.

Setting a Client

A From the [Start] button on the task bar, point to [Program], point to [SmartDe-
viceMonitor for Client], and then click [Extended Features Settings].

A dialog box for setting the expansion function appears.

B  Select the [Notify of printout/data-transmission/cancellation.] check box, and then
click [Detailed Settings].

C Select the [Notify of printout/data-transmission when using print server] check box
on the [Notification Settings] screen.

D Click [OK].

The dialog box for setting the expansion function closes. The client setting is
completed.

Note

❒ Set the printing notification function on the printer driver as well as on
SmartDeviceMonitor for Client.
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Using NetWare

This section describes the setting procedure for network printers in the NetWare
environment. In the NetWare environment, you can connect the machine as a
“print server” or “remote printer”.

Important

❒ IPv6 cannot be used on this function.

❖ Setting procedure

• When using the machine as a print server

A  Installing SmartDeviceMonitor for Admin

B Setting the network interface board.

C Turning the machine off and then back on.

•  When using the machine as a remote printer

A Installing SmartDeviceMonitor for Admin.

B Setting the network interface board. 

C Setting NetWare.

D Starting the print server.

Note

❒ This procedure assumes an environment is already prepared for normal Net-
Ware running the printing service setting.

❒ The procedure is explained with the following example settings:

• File server’s name …CAREE

• Print server’s name …PSERV

• Printer’s name …R-PRN

• Queue name …R-QUEUE

❖ Using SmartDeviceMonitor for Admin
To use the machine in a NetWare environment, use SmartDeviceMonitor for
Admin to set the NetWare printing environment. 

Note

❒ The NetWare Client provided by Novell is required to set the printing en-
vironment using SmartDeviceMonitor for Admin under the following en-
vironments:

• NDS mode in Windows 95/98/Me

• NDS or Bindery mode in Windows 2000/XP, Windows NT 4.0

Reference

For details about installing SmartDeviceMonitor for Admin, see p.39 “In-
stalling SmartDeviceMonitor for Admin”
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❖ Printers listed by SmartDeviceMonitor for Admin
SmartDeviceMonitor for Admin lists printers connected to the network. If
you cannot identify the machine you want to configure, print configuration
page, and then check the machine name.

Setting Up as a Print Server (NetWare 3.x)

Follow the procedure below to connect the machine as a print server using Net-
Ware 3.x.

A Log on to the file server as a supervisor or supervisor equivalent.

B Start NIB Setup Tool from the [Start] menu.

C Click [Wizard], and then click [OK].

D Select the printer you want to configure, and then click [Finish].

A dialog box prompting you to perform the remaining configuration tasks in
the Web browser appears. Click [OK], and then wait until Web Image Monitor
starts automatically.

E A dialog box for entering the [User Name] and [Password] appears.

Enter the user name and password, and then click [OK].

For details about the login user name and password, consult your network
administrator.

F Click [Configuration] in the left area, click [Network], and then click [NetWare].

• Print Server Name: Enter the NetWare print server name. To use the inter-
face board as a print server, enter the name of a print server that is not ac-
tive on the file server. Use up to 47 characters.

• Logon Mode: Specify whether to designate a file server or NDS tree when
logging on to NetWare.

• File Server Name: When a file server name is entered here, only the speci-
fied file server is searched for. This item is mandatory. Use up to 47 char-
acters.

• NDS Tree: To enable NDS mode, enter the name of the NDS tree you want
to log on to. Use up to 32 alphanumeric characters.

• NDS Context Name: To enable NDS mode, enter the print server context.
Use up to 127 characters.

• Operation Mode: Specify whether to use the interface board as a print serv-
er or a remote printer.

• Remote Printer No.: This item is effective when the interface board is spec-
ified as a remote printer. Enter the same number as the number of the
printer to be created on the print server (0 to 254 characters).
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• Job Timeout: When the interface board is used as a NetWare remote print-
er, the printer cannot detect when a print job ends. Therefore, the printer
terminates printing when a certain period of time has elapsed since it last
received print data (i.e., when it has not received print data for a certain pe-
riod of time). Specify here this period of time (3 to 255 seconds). The initial
value is 15 (seconds).

• Frame Type: Select the frame type from the drop-down menu.

• Print Server Protocol: Select the protocol for NetWare from the drop-down
menu.

• NCP Delivery Protocol: Select the protocol for NCP delivery.

G Confirm the settings, and then click [Apply].

Configuration is now complete. Wait several before restarting Web Image
Monitor.

H Click [Logout].

Note

❒ To check the configuration is correct, enter the following from the com-
mand prompt:

F:> USERLIST

❒ If the printer works as configured, the name of the print server appears as
a connected user.

❒ If you cannot identify the printer you want to configure, check the printer
name against the configuration page printed from the printer. For details
about printing a configuration page, see “Printer Reference”. 

❒ If no printer names appear in the list, match the frame types of IPX/SPXs
for the computer and printer. Use the [Network] dialog box of Windows to
change the frame type of the computer.

Setting Up as a Print Server (NetWare 4.x, 5 / 5.1, 6 / 6.5)

Follow the procedure below to connect the machine as a print server using Net-
Ware 4.x, NetWare 5 / 5.1, or NetWare 6 / 6.5.

Important

❒ When using the printer as a print server in NetWare 4.x, NetWare 5 / 5.1, or
NetWare 6 / 6.5, set it to the NDS mode.

❒ When using NetWare 5 / 5.1 or NetWare 6 / 6.5, set the printer as a print server.

A Log on to the file server as an administrator or administrator equivalent.

B Start NIB Setup Tool from the [Start] menu.

C Click [Wizard], and then click [OK].
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D Select the printer you want to configure, and then click [Finish].

A dialog box prompting you to perform the remaining configuration tasks in
the Web browser appears. Click [OK], and then wait until Web Image Monitor
starts automatically.

E A dialog box for entering the [User Name] and [Password] appears.

Enter the user name and password, and then click [OK].

For details about the login user name and password, consult your network
administrator.

F Click [Configuration] in the left area, click [Network], and then click [NetWare].

G Confirm the settings, and then click [Apply].

Configuration is now complete. Wait several minutes before restarting Web
Image Monitor.

H Click [Logout].

Reference

p.22 “Setting Up as a Print Server (NetWare 3.x)”

Using Pure IP in the NetWare 5 / 5.1 or 6 / 6.5 Environment

Follow the procedure below to connect the machine as a print server in a pure IP
environment of NetWare 5 / 5.1 or NetWare 6 / 6.5.

Important

❒ When creating a queued print server in a pure IP environment of NetWare 5
/ 5.1 or NetWare 6 / 6.5, create a print queue on the file server using NetWare
Administrator.

❒ This printer is not available as a remote printer for use in a pure IP environ-
ment.

Setting up using NWadmin

A From Windows, start NWadmin.

For details about NWadmin, see the NetWare manuals.

B Select the object in which the print queue is located in the directory tree,
and then click [Create] on the [Object] menu.

C In the [Class of new object] box, click [Print Queue], and then click [OK].

D In the [Print Queue Name] box, enter the name of the print queue.

E In the [Print Queue Volume] box, click [Browse].
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F In the [Available objects] box, click the volume in which the print queue is
created, and then click [OK].

G Check the settings, and then click [Create].

H Select the object in which the printer is located, and then click [Create] on
the [Object] menu.

I In the [Class of new object] box, click [Printer], and then click [OK]. For Net-
Ware 5, click [Printer (Non NDPS)].

J In the [Printer name] box, enter the printer name.

K Select the [Define additional properties] check box, and then click [Create].

L Click [Assignments], and then click [Add] in the [Assignments] area.

M In the [Available objects] box, click the queue you created, and then click [OK].

N Click [Configuration], click [Parallel] in the [Printer type] list, and then click
[Communication].

O Click [Manual load] in the [Communication type] area, and then click [OK].

P Check the settings, and then click [OK].

Q Select a context specified using NIB Setup Tool, and then click [Create] on
the [Object] menu.

R In the [Class of new object] box, click [Print Server], and then click [OK]. For
NetWare 5, click [Print Sever (Non NDPS)].

S In the [Print Server Name] box, enter the print server name.

Use the same print server name specified using NIB Setup Tool.

T Select the [Define additional properties] check box, and then click [Create].

U Click [Assignments], and then click [Add] in the [Assignments] area.

V In the [Available objects] box, click the queue you created, and then click [OK].

W Check the settings, and then click [OK].

X Start the print server by entering the following from the console of the Net-
Ware server.

If the print server is in operation, quit and restart it.

❖ To exit

CAREE: unload pserver

❖ To start

CAREE: load pserver print_server_name
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Setting up using NIB Setup Tool

A Log on to the file server as an administrator or administrator equivalent.

B Start NIB Setup Tool from the [Start] menu.

C Click [Property Sheet], and then click [OK].

D Select the printer you want to configure, and then click [Finish].

A dialog box prompting you to perform the remaining configuration tasks in
the Web browser appears. Click [OK], and then wait until Web Image Monitor
starts automatically.

E A dialog box for entering the [User Name] and [Password] appears.

Enter the user name and password, and then click [OK].

For details about the login name and password, consult your network admin-
istrator.

F Click [Configuration] in the left area, click [Network], and then click [NetWare].

G Confirm the settings, and then click [Apply].

Configuration is now complete. Wait several minutes before restarting Web
Image Monitor.

H Click [Logout].

Reference

For details , see p.22 “Setting Up as a Print Server (NetWare 3.x)”

Setting Up as a Remote Printer (NetWare 3.x)

Follow the procedure below to use the machine as a remote printer under Net-
Ware 3.x.

Setting up using PCONSOLE

A Enter “PCONSOLE” from the command prompt.

F:> PCONSOLE

B Create a print queue.

When using the existing print queue, go to the procedure for creating a printer.

C From the [Available Options] menu, select [Print Queue Information], and then
press the {Enter} key.

D Press {Insert} key, and then enter a print queue name.

E Press {Esc} key to return to the [Available Options] menu.
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F Set up the network connection to a printer.

G On the [Available Options] menu, click [Print Server Information], and then press
the {Enter} key.

H To create a new print server, press the {Insert} key, and then enter a print
server name.

For a currently defined print server, select a print server in the [Print Server]
list.

Use the same printer name specified using NIB Setup Tool.

I From the [Print Server Information] menu, select [Print Server Configuration].

J From the [Print Server Configuration] menu, select [Printer Configuration].

K Select the printer indicated as [Not Installed].

Use the same printer number specified as the remote printer number using
NIB Setup Tool.

L To change the printer name, enter a new name.

A name “printer x” is assigned to the printer. The “x” stands for the number
of the selected printer.

M As type, select [Remote Parallel, LPT1].

The IRQ, Buffer size, Starting form, and Queue service mode are automatical-
ly configured.

N Press the {Esc} key, and then click [Yes] on the confirmation message.

O Press the {Esc} key to return to [Print Server Configuration Menu].

P Assign print queues to the created printer.

Q From [Print Server Configuration Menu], select [Queues Serviced By Printer].

R Select the printer created.

S Press the {Insert} key to select a queue serviced by the printer. 

You can select several queues.

T Follow the instructions on the screen to make other necessary settings.

Following these steps, check that the queues are assigned.

U Press the {Esc} key until "Exit?" appears, and then select [Yes] to exit
PCONSOLE.

V Start the print server by entering the following from the console of the Net-
Ware server.

 If the print server is in operation, quit and restart it.
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❖ To quit

CAREE: unload pserver

❖ To start

CAREE: load pserver print_server_name

Note

❒ If the printer works as configured, the message “Waiting for job” appears.

Setting up using NIB Setup Tool

A Log on to the file server as a supervisor or supervisor equivalent.

B Start NIB Setup Tool from the [Start] menu.

C Click [Property Sheet], and then click [OK].

D Select the printer you want to configure, and then click [Finish].

A dialog box prompting you to perform the remaining configuration tasks in
the Web browser appears. Click [OK], and then wait until Web Image Monitor
starts automatically.

E A dialog box for entering the [User Name] and [Password] appears.

Enter the user name and password, and then click [OK].

For details about the login user name and password, consult your network
administrator.

F Click [Configuration] in the left area, click [Network], and then click [NetWare].

G Confirm the settings, and then click [Apply].

Configuration is now complete. Wait several minutes before restarting Web
Image Monitor.

H Click [Logout].

Reference

For details, see p.22 “Setting Up as a Print Server (NetWare 3.x)”

Setting Up as a Remote Printer (NetWare 4.x, 5 / 5.1, 6 / 6.5)

Follow the procedure below to use the printer as a remote printer under Net-
Ware 4.x, 5 / 5.1 and 6 / 6.5.

Important

❒ To use the printer as a remote printer under NetWare 4.x, 5 / 5.1, 6 / 6.5, set
it to NDS mode.

❒ Do not use the printer as a remote printer when Pure IP is used. 
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Setting up using NWadmin

A From Windows, start NWadmin.

For details about NWadmin, see the NetWare manuals.

B Set up the network connection to a print queue. Select the object in which
the print queue is located in the directory tree, and then click [Create] on the
[Object] menu.

C In the [Class of new object] box, click [Print Queue], and then click [OK].

D In the [Print Queue Name] box, enter the name of the print queue.

E In the [Print Queue Volume] box, click [Browse].

F In the [Available objects] box, click the volume in which the print queue is
created, and then click [OK].

G Check the settings, and then click [Create].

H Set up the network connection to a printer. Select the object in which the
printer is located, and then click [Create] on the [Object] menu.

I In the [Class of new object] box, click [Printer], and then click [OK]. For Net-
Ware 5, click [Printer (Non NDPS)].

J In the [Printer name] box, enter the printer name

K Select the [Define additional properties] check box, and then click [Create].

L Assign print queues to the created printer. Click [Assignments], and then
click [Add] in the [Assignments] area.

M In the [Available objects] box, click the queue you created, and then click [OK].

N Click [Configuration], click [Parallel] in the [Printer type] list, and then click
[Communication].

O Click [Manual load] in the [Communication type] area, and then click [OK].
Check the settings, and then click [OK].

P Set up the network connection to a print server. Select a context specified
using NIB Setup Tool, and then click [Create] on the [Object] menu.

Q In the [Class of new object] box, click [Print Server], and then click [OK]. For
NetWare 5, click [Print Sever (Non NDPS)].

R In the [Print Server Name:] box, enter the print server name.

Use the same print server name specified using NIB Setup Tool.

S Select the [Define additional properties] check box, and then click [Create].

T Assign the printer to the created print server. Click [Assignments], and then
click [Add] in the [Assignments] area.
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U In the [Available objects] box, click the queue you created, and then click [OK].

V In the [Printers] area, click the printer you assigned, and then click [Printer
Number] 

W Enter the printer number, and then click [OK]. Check the settings, and then
click [OK].

Use the same printer number specified as the remote printer number using
NIB Setup Tool.

X Start the print server by entering the following from the console of the Net-
Ware server.

If the print server is in operation, quit and restart it.

❖ To exit

CAREE: unload pserver

❖ To start

CAREE: load pserver print_server_name

Setting up using NIB Setup Tool

A Log on to the file server as an administrator or administrator equivalent.

B Start NIB Setup Tool from the [Start] menu.

C Click [Property Sheet], and then click [OK].

D Select the printer you want to configure, and then click [Finish].

A dialog box prompting you to perform the remaining configuration tasks in
the Web browser appears. Click [OK], and then wait until Web Image Monitor
starts automatically.

E A dialog box for entering the [User Name] and [Password] appears.

Enter the user name and password, and then click [OK].

For details about the login user name and password, consult your network
administrator.

F Click [Configuration] in the left area, click [Network], and then click [NetWare].

G Confirm the settings, and then click [Apply].

Configuration is now complete. Wait several minutes before restarting Web
Image Monitor.

H Click [Logout].

Reference

For details, see p.22 “Setting Up as a Print Server (NetWare 3.x)”
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2. Monitoring and Configuring
the Printer

Using Web Image Monitor

Using Web Image Monitor, you can check the machine status and change set-
tings.

❖ Available operations
The following operations can be remotely performed using Web Image Mon-
itor from a client computer.

• Displaying machine status or settings

• Checking the print job status or history

• Checking, modifying, printing, or deleting print jobs stored in the Docu-
ment Server

• Interrupting currently printing jobs

• Resetting the printer

• Managing the Address Book 

• Making machine settings

• Making network protocol settings

• Making security settings

❖ Configuring the machine
To perform the operations from Web Image Monitor, TCP/IP is required. Af-
ter the machine is configured to use TCP/IP, operations from Web Image
Monitor become available.

❖ Recommended Web browser

• Windows:
Internet Explorer 5.5 SP1 or higher
Netscape Navigator 6.2 or higher

• Mac OS:
Netscape Navigator 6.2 or higher
Safari 1.0 or higher
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Note

❒ To use Netscape Navigator with Secured Sockets Layer (SSL: an encryption
protocol), use Netscape Navigator 7.0 or higher. 

❒ Safari cannot be used on Mac OS X 10.4.1.

❒ If the previous versions of the Web browser above are used or JavaScript and
cookies are not enabled with the Web browser used, display and operation
problems may occur.

❒ If you are using a proxy server, change the Web browser settings. Contact
your network administrator for information about the settings.

❒ The previous page may not appear even after the back button of a Web
browser is clicked. If this happens, click the refresh button of a Web browser.

❒ Updating the machine information is not automatically performed. Click [Re-
fresh] in the display area to update the machine information.

❒ We recommend using Web Image Monitor in the same network. 

❒ You cannot access to the machine from outside the firewall.

❒ When using the machine under DHCP, the IP address may be automatically
changed by the DHCP server settings. Enable DDNS setting on the machine,
and then connect using the machine's host name. Alternatively, set a static IP
address to the DHCP server.

❒ If the HTTP port is disabled, connection to the machine using the machine's
URL cannot be established. SSL setting must be enabled on this machine. For
details, consult your network administrator.

❒ When using the SSL encryption protocol, enter “https://(printer's ad-
dress)/”. Internet Explorer must be installed on your computer. Use the most
recent available version. We recommend Internet Explorer 6.0 or later.
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Displaying Top Page

This section explains the Top Page and how to display Web Image Monitor.

A Start your Web browser.

B Enter “http: //(machine's address)/” in the address bar of a Web browser.

Top Page of Web Image Monitor appears.

If the machine's host name has been registered on the DNS or WINS server,
you can enter it.

When setting SSL, a protocol for encrypted communication, under environ-
ment which server authentication is issued , enter “https://(machine's ad-
dress)/”.

Every Web Image Monitor page is divided into the following areas:

1. Header area

The link to help and dialog box for
keyword search appears.

2. Menu area

The dialog box for switching to the
user mode and administrator mode
appears, and each mode's menu will
be displayed. 

If you select menu, it's content will be
shown on the work area, or the sub ar-
ea.

3. Display area

Displays the contents of the item se-
lected in the menu area.

Machine information in the display
area is not automatically updated.
Click [Refresh] at the upper right in the
display area to update the machine in-
formation. Click the Web browser's
[Refresh] button to refresh the entire
browser screen.

Machine status, network interface
board names, and comments are dis-
played.

4. Help

Use Help to view or download Help
file contents.

1

3

4

4
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When user authentication is set

Login (using Web Image Monitor)

Follow the procedure below to log on when user authentication is set.

A Click [Login].

B Enter a login user name and password, and then click [OK].

Note

❒ For user code authentication, enter a user code in [User Name], and then
click [OK].

❒ The procedure may differ depending on the Web browser used.

Log Off (using Web Image Monitor)

Click [Logout] to log off.
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About Menu and Mode

There are two modes available with Web Image Monitor: user mode and admin-
istrator mode.

Displayed Items may differ depending on the machine type.

❖ About User Mode
In the user mode, machine status, settings, and print job status can be viewed,
but the machine settings cannot be changed.

1. Status 

Machine status, including the amount
of remaining paper in paper trays and
the amount of remaining toner, is dis-
played.

2. Job 

Allows you to display list of Spooled
print Job, Job History, Error Log,
Locked Print and Sample Print jobs.
This also perform or delete Locked
Print and Sample print jobs.

3. Configuration

Display current machine and network
settings, and download help files.

1

2

3
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❖ Administrator Mode
In the administrator mode, you can configure various machine settings.

1. Status 

Machine status, including the amount
of remaining paper in paper trays and
the amount of remaining toner, is dis-
played.

2. Job 

Allows you to display list of Spool
Print Job, Job History, Error Log,
Locked Print and Sample Print jobs.
This also allows you to delete Spooled
Print Job, Locked Print and Sample
Print jobs.

3. Address Book 

User information can be registered,
displayed, changed, and deleted.

4. Configuration 

Make system settings for the machine,
interface settings, and security.

5. Reset Printer Job 

Click to reset current print jobs and
print jobs in queue. This button is lo-
cated on Top Page.

6. Reset Device 

Click to reset the printer. If a print job
is being processed, the printer will be
reset after the print job is completed.
This button is located on Top Page.

Access in the Administrator Mode

Follow the procedure below to access Web Image Monitor in the administrator
mode.

A On Top Page, click [Login].

The window for entering the login user name and password appears.

B Enter your login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

1
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Displaying Web Image Monitor Help

When using Help for the first time, clicking either [Help] in the header area or the
icon marked “?” in the display area makes the following screen appear, in which
you can view Help in two different ways, as shown below:

❖ Viewing Help on our Web site
Downloading Help to your computer

❖ Downloading and Checking Help
You can download Help to your computer. As the Help URL, you can specify
the path to the local file to view the Help without connecting to the Internet.

Note

❒ By clicking [Help] in the header area, the contents of Help appear.

❒ By clicking “?”, the Help icon in the display area, Help for the setting items in
the display area appears.

Downloading Help

A In the [OS] list, select the operating system.

B In the [Language] list, select the language.

C Click [Download].

D Download Help by following the instructions on the screen.

E Store the downloaded compressed file in a location, and then decompress
the file.

To view the downloaded Web Image Monitor Help, set the path to the loca-
tion of the decompressed file.

Linking the URL of the Help File to the [Help] Button.

You can link the URL of the help file on a computer or Web server to the [Help]
button.

A Log on to Web Image Monitor in the administrator mode.

B In the menu area, click [Configuration].

C Click [Webpage].

D In the [Set Help URL Target] box, enter the URL of the help file.

If you saved the help file to “C:\HELP\EN”, enter “file://C:/HELP/”. For
example, if you saved the file to a Web server, and the URL of the index file
is “http:// a.b.c.d/HELP/EN/index.html”, enter “http://a.b.c.d/HELP/”.

E Click [Apply].
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Using SmartDeviceMonitor for Admin

Using SmartDeviceMonitor for Admin, you can monitor the network printers.
Also, you can change the configuration of the network interface board using
TCP/IP or IPX/SPX.

Important

❒ IPv6 cannot be used on this function.

❖ Protocol stack provided with Operating System

• Windows 95/98/Me
TCP/IP
IPX/SPX
NetWare
NetWare Client32 for Windows 95
IntraNetWare Client for Windows 95
Novell Client for Windows 95/98/Me

• Windows 2000
TCP/IP
IPX/SPX
NetWare
Novell Client for Windows NT/2000/XP

• Windows Server 2003
TCP/IP
IPX/SPX

• Windows XP
TCP/IP
IPX/SPX
Novell Client for Windows NT/2000/XP

• Windows NT 4.0
TCP/IP
IPX/SPX
Client Service for NetWare
NetWare Client32 for Windows NT
IntraNetWare Client for Windows NT
Novell Client for Windows NT/2000/XP
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❖ Available operations
The following functions are available:

• Limits settings done from the control panel, and disables changes made to
certain items.

• Enables selection of paper type loaded in the machine.

• Switches to, and comes out of Energy Saver mode.

• Checks information about printing, paper quantity, etc.

• Simultaneously monitors multiple printers. When there are many printers,
you can create groups and classify printers to facilitate management.

• Checks the machine's network settings and detailed device information.

• Enables you to change the machine's network settings.

• You can check details of print jobs sent from a computer.

• Allows you to check job histories of printed, faxed (LAN-Fax), scanned,
and photocopied documents identified by user codes.

• Allows selection of functions such as printing and scanning for each user
code.

• Fax numbers and e-mail addresses stored in the machine can be changed
and saved by computer.

• You can check each fax job history entry.

• You can make settings for and display the status changes of group devices.

• Using Address Management Tool, you can manage LAN-Fax numbers,
user names for Scan to Folder, and addresses for sending and receiving In-
ternet faxes.

• The e-mail sender’s name and folder can be protected.

Installing SmartDeviceMonitor for Admin

Follow the procedure below to install SmartDeviceMonitor for Admin

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

C Select an interface language, and then click [OK].

The following languages are available: Czech, Danish, German, English,
Spanish, French, Italian, Hungarian, Dutch, Norwegian, Polish, Portuguese ,
Finnish, Swedish, Chinese Simple and Chinese Traditional.

D Click [SmartDeviceMonitor for Admin].

E Click [Next >].

The software license agreement appears in the [License Agreement] dialog box.
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F After reading through its contents, click [Next >].

G Follow the instructions on the screen.

A message appears when the installation is completed.

H Click [OK].

A message about restarting the computer may appear. Restart the computer
to complete installation.

Note

❒ Auto Run may not work under certain operating system settings. In this
case, launch “Setup.exe” located on the CD-ROM root directory.

❒ If you are required to restart the computer after installing SmartDevice-
Monitor for Admin, restart the computer and continue the configuration.

Changing the Network Interface Board Configuration

Follow the procedure below to change the network interface board configura-
tion using SmartDeviceMonitor for Admin.

A Start SmartDeviceMonitor for Admin.

B On the [Group:] menu, point to [Search Device], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using TCP/IP SNMP v3, enter the user authentication.

C In the list, select a machine whose configuration you want to change.

D On the [Tools] menu, click [NIB Setup Tool].

A Web browser opens and the window for entering the login user name and
password for the Web Image Monitor administrator appears.

NIB Setup Tool starts when the network interface board is default. Click [Web
Browser], and then click [OK].

E Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator. 

F Configure settings using Web Image Monitor.

G Quit Web Image Monitor. 

H Quit SmartDeviceMonitor for Admin.

Reference

p.31 “Using Web Image Monitor”
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Locking the Menus on the Machine's Control Panel

Follow the procedure below to lock the menus on the machine's control panel.

A Start SmartDeviceMonitor for Admin.

B On the [Group:] menu, point to [Search Device], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using TCP/IP SNMP v3, enter the user authentication.

C Select a machine.

D On the [Tools] menu, point to [Device Settings], and then click [Lock Operation
Panel Menu].

A Web browser opens and the window for entering the login user name and
password for the Web Image Monitor administrator appears.

E Enter the login user name and password, and then click [Login].

For details about the user name and password, consult your network admin-
istrator.

The [System] page of Web Image Monitor appears. Enter required setting
items.

F Select [Level 1] or [Level 2] in the [Protect Printer Operation Panel] list. 

G Click [Apply].

H Quit Web Image Monitor.

I Quit SmartDeviceMonitor for Admin.

Note

❒ For details about setting items, see Help in the [General Settings] on [Config-
uration] page.

Changing the Paper Type

Follow the procedure below to change the paper type.

A Start SmartDeviceMonitor for Admin.

B On the [Group:] menu, point to [Search Device], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using TCP/IP SNMP v3, enter the user authentication.
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C In the list, select a machine whose configuration you want to change.

D On the [Tools] menu, point to [Device Settings], and then click [Select Paper
Type].

A Web browser opens and the window for entering the login user name and
password for the Web Image Monitor administrator appears.

E Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

The [Paper] page appears. 

F Select a paper type in the [Paper Type] list for each tray. Enter required set-
ting items.

G Click [Apply].

H Quit Web Image Monitor.

I Quit SmartDeviceMonitor for Admin.

Note

❒ For details about setting items, see Help in the [General Settings] on [Config-
uration] page.

Managing User Information

Follow the procedure below to manage the user's information using SmartDe-
viceMonitor for Admin.

Prints jobs can be managed and functions restricted by user codes.

Starting User Management Tool

Follow the procedure below to start User Management Tool.

A Start SmartDeviceMonitor for Admin.

B On the [Group:] menu, point to [Search Device], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using TCP/IP SNMP v3, enter the user authentication.

C In the list, select a machine you want to manage.

D On the [Tools] menu, click [User Management Tool].

The dialog box for entering the login user name and password appears.
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E Enter the user name and password, and then click [OK].

For details about the user name and password, consult your network admin-
istrator.

User Management Tool starts.

Note

❒ For details about User Management Tool, see SmartDeviceMonitor for Ad-
min Help.

Displaying the Number of Sheets Printed

Follow the procedure below to display the number of sheets printed under each
user code.

A Start SmartDeviceMonitor for Admin User Information Management Tool.

B Click the [User Page Count] tab of User Management Tool.

The number of pages printed under each user code appears.

C Click [Exit] on the [File] menu to quit User Management Tool.

Exporting the information about the number of pages printed

Follow the procedure below to export the information of the number of pages
printed under each user code as a .csv file.

A Start SmartDeviceMonitor for Admin User Information Management Tool.

B Click the [User Page Count] tab of User Management Tool.

C On the [File] menu, click [Export User Statistics List].

D Specify the save location and file name, and then click [Save].

E Click [Exit] on the [File] menu to quit User Management Tool.

Resetting the number of pages printed to 0.

Follow the procedure below to reset the number of pages printed under each
user code to 0.

A Start SmartDeviceMonitor for Admin User Information Management Tool.

B Click the [User Page Count] tab of User Management Tool.

C Click the user whose information you want to reset.

D On the [Edit] menu, click [Reset User Counters].

E Select the check box of the items you want to reset, and then click [OK].

A confirmation message appears.
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F Click [OK].

The number of pages printed is reset to 0.

G On the [Edit] menu, click [Apply Settings].

Changes are applied to information on the [User Page Count] tab.

H Click [Exit] on the [File] menu to quit User Management Tool.

Restricting Functions

Follow the procedure below to restrict use of individual functions.

A Start SmartDeviceMonitor for Admin User Information Management Tool.

B Click the [User Counter Information] tab of User Management Tool.

C On the [Edit] menu of User Management Tool, click [Restrict Access To De-
vice].

D Select the check box of the functions you want to restrict.

E Click [OK].

A confirmation message appears.

F Click [Yes].

The settings are applied.

Setting Applicable Functions to New Users

Follow the procedure below to add new users and set functions applicable to
them.

A Start SmartDeviceMonitor for Admin User Information Management Tool.

B Click the [Access Control List:] tab of User Management Tool.

C On the [Edit] menu, click [Add New User].

D Enter the user code and user name.

E Select the check box of the functions applicable to the new user.

If the check boxes are unavailable, there is no restriction to use that function.

F Click [OK].

The new user is added.

G On the [Edit] menu, click [Apply Settings].

The settings are applied.

H Click [Exit] on the [File] menu to quit User Management Tool.
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Note

❒ For details about setting restrictions, see SmartDeviceMonitor for Admin
Help.

Configuring the Energy Saver Mode

Follow the procedure below to configure Energy Saver mode.

A Start SmartDeviceMonitor for Admin.

B On the [Group:] menu, point to [Search Device], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using TCP/IP SNMP v3, enter the user authentication.

C Select the machine whose settings you want to make.

To make settings for all machines in the selected group, select no machine.

D On the [Group:] menu, point to [Energy Save Mode], point to [Set Individually] to
make the settings for only the selected machine or point to [Set By Group] to
make the settings for all machines in the selected group, and then click [On]
or [Off].

E Quit SmartDeviceMonitor for Admin.

Note

❒ For details about the setting for Energy Saver mode, see SmartDeviceMon-
itor for Admin Help.

Setting a Password

Follow the procedure below to set a password.

A Start SmartDeviceMonitor for Admin.

B On the [Group:] menu, point to [Search Device], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using TCP/IP SNMP v3, enter the user authentication.

C In the list, select a machine whose configuration you want to change.
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D On the [Tools] menu, click [NIB Setup Tool].

A Web browser opens and the dialog box for entering the login user name
and password for the Web Image Monitor administrator appears.

NIB Setup Tool starts when the network interface board is default. Follow the
instructions on the screen.

E Enter the login user name and password, and then click [Login].

For details about the user name and password, consult your network admin-
istrator.

Top Page of Web Image Monitor appears.

F Click [Configuration].

G Click [Program / Change Administrator] on the [Device Settings] area, and then
change the settings.

H Click [Change].

I On the [New Password], enter a password.

Enter the same password in [Confirm Password] .

J  Click [OK].

K Click [Apply].

L Quit Web Image Monitor.

M Quit SmartDeviceMonitor for Admin.

Checking the Machine Status

Follow the procedure below to check machine status.

A Start SmartDeviceMonitor for Admin.

B On the [Group:] menu, point to [Search Device], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using TCP/IP SNMP v3, enter the user authentication.

C To obtain status details, select the machine in the list, and then click [Open]
on the [Device] menu.

The machine status appears in the dialog box.

D Click [System] or [Printer].

The machine status appears in the dialog box.
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E Quit SmartDeviceMonitor for Admin.

Note

❒ For details about items in the dialog box, see SmartDeviceMonitor for Ad-
min Help.

Changing Names and Comments

Follow the procedure below to change the names and comments of the machine.

A Start SmartDeviceMonitor for Admin.

B On the [Group:] menu, point to [Search Device], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using TCP/IP SNMP v3, enter the user authentication.

C  Select a machine in the list, and then click [NIB Setup Tool] on the [Tools]
menu.

A Web browser opens and the window for entering the login user name and
password for the Web Image Monitor administrator appears.

NIB Setup Tool starts when the network interface board is default. Follow the
instructions on the screen.

D Enter the login user name and password, and then click [Login].

Top Page of Web Image Monitor appears.

For details about the login user name and password, consult your network
administrator.

E Click [Configuration].

F Click [Device Settings].

G On the [System] page, enter the device name in the [Device Name] box and a
comment in the [Comment] box, and click [Apply].

• In the [Device Name] box, enter a device name on the machine using up to
31 characters.

• In the [Comment] box, enter a comment on the machine using up to 31 char-
acters.

H Click [OK].

I Quit Web Image Monitor.

J Quit SmartDeviceMonitor for Admin.
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Load Fax Journal

A Start SmartDeviceMonitor for Admin.

B On the [Group:] menu, point to [Search Device], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using TCP/IP SNMP v3, enter the user authentication.

C Select a machine in the list, and then click [Load Fax Journal] on the [Tools]
menu.

A Web browser opens and the dialog box for entering the login user name
and password for the Web Image Monitor administrator appears.

D Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

Load Fax Journal area appears in the Web Image Monitor.

E Quit Web Image Monitor.

F Quit SmartDeviceMonitor for Admin.

Note

❒ For details, see Help in [Load Fax Journal] area.

Viewing and Deleting Spool Print Jobs

A Start SmartDeviceMonitor for Admin.

B On the [Group:] menu, point to [Search Device], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using TCP/IP SNMP v3, enter the user authentication.

C Select a machine in the list, and then click [Spool Printing Job List(Printer)] on
the [Tools] menu.

A Web browser opens and the dialog box for entering the login user name
and password for the Web Image Monitor administrator appears.
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D Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

Spool Printing Job List appears in the Web Image Monitor.

To delete the Spool Printing Job, select the document you want to delete and
then click [Delete].

Note

❒ To display Spool Printing Job List, spool must be set to [Enable] on Web Im-
age Monitor in advance.

❒ For details, see Help in the Spool Printing Job List area.

Managing Address Information

A Start SmartDeviceMonitor for Admin.

B On the [Group:] menu, point to [Search Device], and then click [TCP/IP],
[IPX/SPX] or [TCP/IP SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using TCP/IP SNMP v3, enter the user authentication.

C Select a machine in the list, and then click [Address Management Tool]on the
[Tools] menu.

The dialog box for entering the login user name and password appears.

D Enter the login user name and password, and then click [Login].

Address Management Tool starts.

 For details about the login user name and password, consult your network
administrator. 

Note

❒ For details, see Address Management Tool Help.
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Using SmartDeviceMonitor for Client

To view the status of machines using SmartDeviceMonitor for Client, configure
SmartDeviceMonitor for Client beforehand.

Monitoring Printers

Follow the procedure below to monitor the machine using SmartDeviceMonitor
for Client.

A Right-click the SmartDeviceMonitor for Client icon, point to [Properties],
and then click [Option...].

The [SmartDeviceMonitor for Client - Options] dialog box appears.

B Select the machine you want to monitor, and then select the [To Be Monitored]
check box in the Monitoring Information Settings area.

To display the machine status in the task tray using the SmartDeviceMonitor
for Client icon, select the [Displayed on Task Bar] check box.

C Click [OK].

The dialog box closes and the configured machine is monitored.

Note

❒ For details about status icons, see SmartDeviceMonitor for Client Help.

Checking the Machine Status

Follow the procedure below to check machine status using SmartDeviceMonitor
for Client.

A For status details, right-click the SmartDeviceMonitor for Client icon, and
then click the machine.

The machine status appears in the dialog box.

Note

❒ For details about items in the dialog box, see SmartDeviceMonitor for Cli-
ent Help.
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When Using IPP with SmartDeviceMonitor for Client

When using IPP with SmartDeviceMonitor for Client, note the following:

• The network printer can only receive one print job from SmartDeviceMonitor
for Client at a time. While the network printer is printing, another user cannot
access it until the job is finished. In this case, SmartDeviceMonitor for Client
tries to access the network printer until the retry interval expires.

• If SmartDeviceMonitor for Client cannot access the network printer and times
out, it will stop sending the print job. In this case, you should cancel the
paused status from the print queue window. SmartDeviceMonitor for Client
will resume access to the network printer. You can delete the print job from
the print queue window, but canceling a print job printed by the network
printer might cause the next job sent from another user to be incorrectly print-
ed.

• If a print job sent from SmartDeviceMonitor for Client is interrupted and the
network printer cancels the job because something went wrong, send the
print job again.

• Print jobs sent from another computer do not appear in the print queue win-
dow, regardless of protocol.

• If various users send print jobs using SmartDeviceMonitor for Client to net-
work printers, the printing order might not be the same as that in which the
jobs were sent.

• An IP address cannot be used for the IPP port name because the IP address is
used for the SmartDeviceMonitor for Client port name.

• When setting SSL, a protocol for encrypted communication, under environ-
ment which server authentication is issued, enter “https://(machine's ad-
dress)/”. Internet Explorer must be installed on your computer. Use the
highest version. Internet Explorer 6.0 or higher is recommended.

• If the [Security Alert] dialog box appears when accessing the machine using IPP
to create or configure an IPP port, or when printing, install the certificate. To
select the certificate store location when using Certificate Import Wizard,
click [Place all certificates in the following store], and then click [Local Computer]
under [Trusted Root Certification Authorities].

Note

❒ For details about SSL settings, consult your network administrator.
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Printer Status Notification by E-Mail

Whenever a paper tray becomes empty or paper is jammed, an e-mail alert is is-
sued to the registered addresses to notify the printer status.

For this notification, you can make the e-mail notification settings.

Notification timing and e-mail content can be set.

You can be notified of the following events:

• Call Service

• Out of Toner

• Toner Almost Empty

• Waste Toner Bottle is Full

• Add Staple

• Paper Misfeed

• Cover Open

• Out of Paper

• Paper Tray Error

• Output Tray Full

• Unit Connection Error

• Duplex Unit Error

• Document Server Memory Full

Note

• When the service call is set, following call results can be sent.

• Failure automatic call success

• Failure automatic call out of time

• Failure automatic call failure

• Consumable automatic call success

• Remote machine check failure

• Firmware update confirmed

❒ Other call results can be displayed, depending on the machine type.

❒ For details about the service call, contact your service or sales representative.

A Open a Web browser, and then enter “http://(machine's address)/” in the
address bar.

Top Page of Web Image Monitor appears.

When setting SSL, a protocol for encrypted communication, under environ-
ment which server authentication is issued , enter “https://(machine's ad-
dress)/”.

B Click [Login] on Top Page of Web Image Monitor.

The window for entering the login user name and password appears.
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C Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

D In the menu area, click [Configuration].

E Click [E-mail] on the [Device Settings] area.

FMake the following settings:

• Items in the Reception column: Make the necessary settings for sending
and receiving e-mail. 

• Items in the SMTP column: Configure the SMTP server. Check your mail-
ing environment, and then specify the necessary items. You can also per-
form mail authentication for the SMTP server.

• Items in the POP before SMTP column: Configure the POP server. Check
your mailing environment, and then specify the necessary items. You can
also perform mail authentication for the POP server.

• Items in the POP3/IMAP4 column: Configure the POP3 or IMAP4 server.
Check your mailing environment, and then specify the necessary items.

• Items in the E-mail Communication Port column: Configure the port to be
used for access to the mail server.

• Items in the E-mail Notification column: Items in the E-Mail Notification
Account column: Specify these items if you want to use on-demand e-mail
notification.

G Click [Apply].

Auto E-mail Notification

A Click [Configuration] in the menu area, and then click [Auto E-mail Notification]
on the [Device Settings] area.

The dialog box for making notification settings appears.

BMake the following settings:

• Items in Notification Message column: You can set this according to your
needs, for example, the machine's location, service representative contact
information.

• Items in the Groups to Notify column: E-mail notification addresses can be
grouped as required.

• Items in the Select Groups/Items to Notify column: Select groups for each
notification type, such as machine status and error.
To make detailed settings for these items, click [Edit] next to [Detailed Set-
tings of Each Item].

C Click [Apply].
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D Click [Logout].

E Quit Web Image Monitor.

On-demand E-mail Notification

A Click [Configuration] in the menu area, and then click [On-demand E-mail Notifi-
cation] on the [Device Settings] area.

The dialog box for making notification settings appears.

BMake the following settings:

• Notification Subject: Enter a text string to be added to the subject line of re-
turn e-mails.

• Notification Message: You can set this according to your needs, for exam-
ple, the machine's location, service representative contact information.

• Items in the Access Restriction to Information column: Select whether to
restrict accesses based on a specific category of information.

• Items in the Receivable E-mail Address/Domain Name Settings column:
Enter an e-mail address or domain name to use for requesting information
by e-mail and to receive its return e-mail.

C Click [Apply].

D Click [Logout].

E Quit Web Image Monitor.
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Mail authentication

You can configure mail authentication to prevent illegal use of the mail server.

❖ SMTP Authentication
Specify SMTP authentication (PLAN, LOGIN, CRAM-MD5, and DIGEST-
MD5).
When mail is sent to the SMTP server, authentication is performed using the
SMTP AUTH protocol by prompting the mail originator to enter the user
name and password. This prevents illegal use of the SMTP server.

A In the menu area, click [E-mail]

B Make the following settings:

• SMTP Auth. E-mail Address: Enter the e-mail address.

• SMTP Auth. User Name: Enter the SMTP account name.

• SMTP Auth. Password: To set or change the password for SMTP AUTH.

• SMTP Auth. Encryption: Select whether to encrypt the password or not.

C Click [Apply]

D Click [Logout].

E Quit Web Image Monitor.

❖ POP before SMTP Authentication
Select whether to log on to the POP3 server before sending e-mail.

A In the menu area, click [E-mail].

B Make the following settings:

• POP before SMTP: Enable or disable POP before SMTP.

• POP E-mail Address: Enter the e-mail address.

• POP User Name: Enter the POP account name.

• POP Password: To set or change the POP password.

• Timeout setting after POP Auth.: Enter the time available before con-
necting to the SMTP server after logging on to the POP server. 

C Click [Apply].

D Click [Logout].

E Quit Web Image Monitor.
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On-demand E-mail Notification

To use on-demand e-mail notification, perform the following configuration
tasks in Web Image Monitor.

A In the menu area, click [E-mail].

B Make the following settings:

• E-mail Notification E-mail Address: Enter the address using alphanumeric
characters.

• Receive E-mail Notification: Specify whether to use on-demand e-mail no-
tification.

• E-mail Notification User Name: Enter the administrator's user name as the
mail originator name.

• E-mail Notification Password: Enter the password of the mail notification
user.

C Click [OK].

D Click [Logout].

E Quit Web Image Monitor.

❖ Format of on-demand e-mail messages
To use mail notification, you need to send an on-demand e-mail message to
this machine.
Using your mail software, enter the following:

Note

❒ A mail message must be within 1 MB in size.

❒ E-mail may be incomplete if sent immediately after power on.

❖ Subject field
Format: devicestatus?parameter-name=parameter[&=parameter][&=param-
eter]...

Note

❒ The Subject field is case-insensitive.

❒ Parameter names can be written in any order.

Item Description

Subject (Referred to as Subject) Enter a request regarding the device. For de-
tails, see the table below.

From (Referred to as From) Specify a valid mail address. The device in-
formation will be sent to the address speci-
fied here.
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❖ Subject field coding examples

❖ Parameters

❖ Parameters specifying the information to be obtained

❖ Parameters specifying the mail format

Note

❒ HTML and XML can be selected for subject field, but output is text only.

❖ Parameters that specify the language for mail bodies

Coding example Action

devicestatus?request=sysconfig&for-
mat=text&lang=en

The device's system configuration informa-
tion will be sent in an English text format.

devicestatus?request=sysconfig The device's system configuration informa-
tion will be sent in a preset format and lan-
guage.

Parameter Meaning Default

request Information to be obtained Mandatory

format Mail format Mail will be sent in the for-
mat preset for each mail ad-
dress.

lang Language for mail body Mail will be sent in the lan-
guage preset for each mail 
address.

Information to be obtained Parameter

System configuration information sysconfig

Network configuration information netconfig

Printer configuration information prtconfig

Supplies information supply

Device status information status

Mail format Parameter

Text text

HTML html

XML xml

Language Parameter

Japanese ja

English en
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Remote Maintenance by telnet

Important

❒ Remote Maintenance should be password-protected so that access is allowed
to administrators only. 

❒ The password is the same as the one of Web Image Monitor administrator.
When the password is changed using “mshell”, other passwords change also.

❒ Some command cannot be set depending on the model type.

Using telnet

Follow the procedure below to use telnet.

Important

❒ Only one user at a time can log on to perform remote maintenance.

A Use the IP address or the host name of the machine to start telnet.

% telnet IP_address

B Enter your user name and password.

For details about the user name and password, consult your network admin-
istrator.

For user authentication, enter a login user name and password.

For user code authentication, enter a user code in User Name.

C Enter a command.

D Quit telnet.

msh> logout

The configuration message about saving the changes appears.

E Enter “yes” to save the changes, and then press the {Enter} key.

If you do not want to save the changes, enter “no”, and then press the {Enter}
key. To make further changes, enter “return” at the command line, and then
press the {Enter} key.

Note

❒ If the message “Can not write NVRAM information” appears, the changes
are not saved. Repeat the procedure above.

❒ When the changes are saved, the network interface board is reset automat-
ically with that changes.

❒ When the network interface board resets, the print job in print process will
be printed. However, print jobs in queue will be canceled.
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access

Use the “access” command to view and configure access control. You can also
specify two or more access ranges.

❖ View settings

msh> access

❖ Configuration

msh> access  range “start-address end-address”

• The star mark represents a target number between 1 and 5. (Up to five ac-
cess ranges can be registered and selected.)

Example: to specify accessible IP addresses between 192.168.0.10 and
192.168.0.20:

msh> access 1 range 192.168.0.10 192.168.0.20

❖ Access control initialization 

msh> access flush

• Use the “flush” command to restore the default settings so that all access
ranges become “0.0.0.0”.

Note

❒ The access range restricts computers from use of the machine by IP address.
If you do not need to restrict printing, make the setting “0.0.0.0”.

❒ Valid ranges must be from lower (start address) to higher (end address).

❒ Up to five access ranges can be specified. The entry is invalid if the target
number is omitted.

❒ You cannot send print jobs, or access Web Image Monitor and diprint from a
restricted IP address.

appletalk

Use the “appletalk” command to view and configure Appletalk parameters.

❖ View settings

msh> appletalk

•  [2] means “active” and [0] means “inactive”.

• The default is [2].

❖ Changing PAP timeout configuration

msh> appletalk ptimeout value > 0

• Timeout value becomes effective.

msh> appletalk ptimeout value = 0

• Timeout value becomes ineffective.
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autonet

Use the “autonet” command to configure AutoNet parameters.

❖ View settings
The following command displays the current AutoNet settings:

msh> autonet

❖ Configuration
You can configure AutoNet settings.

msh> autonet {on|off}

•  {on} means “active” and {off} means “inactive”.

❖ Current interface priority configuration display

msh> autonet priority

❖ Interface priority configuration

msh> autonet priority “interface_name”

• You can give interface's AutoNet parameter priority.

• Priority settings are available when multiple interfaces are installed.

• wlan can be specified only when the IEEE 802.11b interface is installed.

Note

❒ If an interface is not selected, the current interface connection settings remain
in effect.

❒ For details about AutoNet, refer to autonet parameters.

btconfig

Use the “btconfig” command to make Bluetooth settings.

❖ View settings
Bluetooth settings are displayed.

msh> btconfig

❖ Mode settings
You can set the Bluetooth operation mode to {private} or {public}.

msh> btconfig {private | public}

• The default is {public}.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface
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devicename

Use the “devicename” command to display and change the printer name.

❖ View settings

msh> devicename

❖ Printer name configuration

msh> devicename name “string”

• Enter a printer name using up to 31 alphanumeric characters.

• Set single names for each printer.

❖ Printer name initialization

msh> devicename clear name

• Reset the printer name to its default.

dhcp

Use the “dhcp” command to configure DHCP settings.

❖ View settings
The following command displays the current DHCP settings.

msh> dhcp

❖ Configuration
You can configure DHCP.

msh> dhcp “interface_name” {on|off}

• Click {on} to enable dhcp. Click {off} to disable DHCP.

• If the DNS server address and domain name are obtained from DHCP, be
sure to click {on}.

• wlan can be specified only when the IEEE 802.11 interface is installed.

❖ Current interface priority configuration display

msh> dhcp priority

❖ Interface priority configuration

msh> dhcp priority “interface_name”

• You can select which interface has DHCP parameter priority.

• Priority settings are available when multiple interfaces are installed.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11 interface
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❖ DNS server address selection

msh> dhcp dnsaddr {dhcp | static}

• Specify whether to obtain the DNS server address from the DHCP server
or use the address set by a user. 

• To obtain the DNS server address from the DHCP server, specify “dhcp”.
To use the address set by a user, specify “static”. 

❖ Domain name selection

msh> dhcp domainname {dhcp | static}

• Specify whether to obtain the domain name from the DNS server or use the
domain name set by a user.

• To obtain the domain name from the DHCP server, specify “dhcp”. To use
the domain name set by a user, specify “static”. 

Reference

p.114 “Using DHCP”

p.63 “dns”

p.64 “domainname”

diprint

The direct printing port enables direct printing from a network-connected com-
puter.

Use the “diprint” command to change direct printing port settings.

❖ View settings
The following command displays the current direct printing port settings:

msh> diprint
Example output:

port 9100
timeout=300(sec)
bidirect on
con multi
apl async

• The “port” specifies the port number of the direct printing port.

• The “bidirect” setting indicates whether the direct printing port is bidirec-
tional or not.

❖ Setting timeout

msh> diprint timeout [30~65535]

• You can specify the timeout interval to use when the printer is expecting
data from the network.

• The default is 300 seconds.
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❖ Specifying the number of concurrent connections

msh> diprint con {multi | single}

• The above command specifies the number of concurrent diprint connec-
tions. Specify “multi” for multiple connections or “single” for a single con-
nection.

• The default is “multi”.

dns

Use the “dns” command to configure or display DNS (Domain Name System)
settings.

❖ View settings
The following command displays current DNS settings:

msh> dns

❖ DNS server configuration
The following command enables or disables the IP DNS server address:

msh> dns “number” server “server address”
The following command displays a configuration using the IP address
192.168.15.16 on a DNS 1 server:

msh> dns 1 server 192.168.15.16

• You can register up to three IP DNS server numbers.

• You cannot use “255.255.255.255” as the DNS server address.

❖ Dynamic DNS function setting

msh> dns “interface_name” ddns {on|off}

• You can set the dynamic DNS function “active” or “inactive”.

•  {on} means “active” and {off} means “inactive”.

• wlan can be specified only when the IEEE 802.11b interface is installed.

❖ Specifying the record overlap operation

msh> dns overlap {update|add}

• You can specify operations performed when records overlap.

• update
To delete old records and register new records.

• add
To add new records and store the old records.

• When CNAME overlaps, it is always changed, irrespective of settings.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface



Monitoring and Configuring the Printer

64

2

❖ CNAME registration

msh> dns cname {on|off}

• You can specify whether to register CNAME.

•  {on} means “active” and {off} means “inactive”.

• The CNAME registered is the default name beginning with rnp. CNAME
cannot be changed.

❖ A records registration

msh> dns arecord {dhcp|own}

• {dhcp}
You can specify the method of registering an A record when the dynamic
DNS function is enabled and DHCP is used.

• {own}
To register an A record using the printer as the DNS client.
The DNS server address and the domain name already designated are
used for the registration.

❖ Record updating interval settings

msh> dns interval “time”

• You can specify the interval after which records are updated when using
the dynamic DNS function.

• The updating interval is specified hourly. It can be entered between 1 and
255 hours.

• The default is 24 hours.

domainname

Use the “domainname” command to display or configure the domain name set-
tings.

You can configure the Ethernet interface, or IEEE 802.11b interface.

❖ View settings
The following command displays the current domain name:

msh> domainname

❖ Interface domain configuration

msh> domainname “interface_name”
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❖ Setting the Domain Name

msh> domainname “interface_name” name “domain name”

• A domain name can be entered using up to 63 alphanumeric characters.

• The Ethernet interface and IEEE 802.11b interface will have the same do-
main name.

• wlan can be specified only when the IEEE 802.11b interface is installed.

❖ Deleting the Domain Name

msh> domainname “interface_name” clear name

help

Use the “help” command to display the available command list and the proce-
dures for using those commands.

❖ Command list display

msh> help

❖ Display of procedure for using commands

msh> help “command_name”

hostname

Use the “hostname” command to change the printer name.

❖ View settings

msh> hostname

❖ Configuration

msh> hostname “interface_name ” “printer_name”

• Enter the printer name using up to 63 alphanumeric characters.

• You cannot use a printer name beginning “RNP” (in either upper or lower
case).

• The Ethernet interface and IEEE 802.11b interface will have the same print-
er name.

• wlan can be specified only when the IEEE 802.11b interface is installed.

Interface Interface set

ether Ethernet interface

wlan IEEE 802.11b interface

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface
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❖ Initializing the printer name for each interface

msh>hostname “interface_name” clear name

ifconfig

Use the “ifconfig” command to view and configure TCP/IP (IP address, subnet
mask, broadcast address, default gateway address) for the printer.

❖ View settings

msh> ifconfig

❖ Configuration

msh> ifconfig “interface_name” “parameter” “address”

• If you did not enter an interface name, it is automatically set to the Ethernet
interface.

• wlan can be specified only when the IEEE 802.11b interface is installed.

The following explains how to configure an IP address 192.168.15.16 on Eth-
ernet interface.

msh> ifconfig ether 192.168.15.16

❖ Netmask configuration

msh> ifconfig “interface_name” netmask “address”
The following explains how to configure a subnet mask 255.255.255.0 on Eth-
ernet interface.

msh> ifconfig ether netmask 255.255.255.0

❖ Broadcast address configuration

msh> ifconfig “interface_name” broadcast “address”

❖ Changing the Interface

msh> ifconfig “interface” up

• You can specify either the Ethernet interface or IEEE 802.11b interface
when using the optional IEEE 802.11b interface unit.

Interface name Interface configured

ether Ethernet Interface

wlan IEEE 802.11b Interface
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Note

❒ To get the above addresses, contact your network administrator.

❒ Use the default configuration if you cannot obtain setting addresses.

❒ The IP address, subnet mask and broadcast address are the same as that for
the ethernet interface and IEEE 802.11b interface.

❒ TCP/IP configuration is the same for both Ethernet and IEEE 802.11 interface.
If interfaces are changed, the new interface inherits the configuration.

❒ Use “0x” as the initial two letters of a hexadecimal address.

info

Use the “info” command to display printer information such as paper tray, out-
put tray, and printer language.

❖ Printer information display

msh> info

Reference

p.87 “Getting Printer Information over the Network”

ipp

Use the “ipp” command to view and configure IPP settings.

❖ Viewing settings
The following command displays the current IPP settings:

msh> ipp

❖ IPP timeout configuration 
Specify how many seconds the computer waits before canceling an interrupt-
ed print job. The time can be entered between 30 to 65535 seconds.

msh> ipp timeout [30 - 65535]

❖ IPP user authorization configuration
Use IPP user authorization to restrict users to print with IPP. The default is
“off”.

msh> ipp auth {basic|digest|off}

• User authorization settings are “basic” and “digest”.

• If user authorization is specified, register a user name. You can register up
to 10 users.
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❖ IPP user configuration
Configure IPP users according to the following messages:

msh> ipp user
The following message appears:

msh> Input user number (1 to 10):
Enter the number, user name, and password.

msh> IPP user name:user1
msh> IPP password:*******
After configuring the settings, the following message appears:

User configuration changed.

netware

Use the “netware” command to view and configure the NetWare settings such
as the print server name or file server name.

❖ Netware Printer Server Names

msh> netware pname character string

• Enter the NetWare print server name using up to 47 characters.

❖ Netware File Server Names

msh> netware fname character string

• Enter the NetWare file server name using up to 47 characters.

❖ Encap type

msh> netware encap {802.3|802.2|snap|ethernet2|auto}

❖ Remote Printer Number

msh> netware rnum {0–254}

❖ Timeout

msh> netware timeout {3–255}

❖ Printer server mode

msh> netware mode pserver
msh> netware mode ps

❖ Remote printer mode

msh> netware mode rprinter
msh> netware mode rp

❖ NDS context name

msh> netware context character string
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❖ SAP interval

msh> netware “sap_interval”

❖ Setting login mode for file server

msh> netware login server

❖ Setting login mode for NDS tree

msh> netware login tree

❖ Setting login mode for NDS tree name

msh> netware tree “NDS name”

❖ File transfer protocol

msh> netware trans {ippri|ipxpri|ip|ipx}

• If you do not specify the protocol, the current setting is displayed. 

passwd

Use the “passwd” command to change the remote maintenance password.

❖ Changing the Password

msh> passwd

• Enter the current password.

• Enter the new password.

• Renter the new password to confirm it.

❖ Changing the Password of the administrators using the Supervisor

msh> passwd {Administrator ID}

• Enter the new password.

• Renter the new password to confirm it.

Note

❒ Be sure not to forget or lose the password.

❒ The password can be entered using up to 32 alphanumeric characters. Pass-
words are case-sensitive. For example, “R” is not the same as “r”.

Protocol Set Protocol

ippri TCP/IP+IPX

ipxpri TCP/IP+IPX

ip TCP/IP

ipx IPX
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prnlog

Use the “prnlog” command to obtain printer log information.

❖ Print logs display

msh> prnlog

• Display 20 previous print jobs.

msh> prnlog “ID Number”

• Specify the ID number of the displayed print log information to display ad-
ditional details about a print job.

Reference

p.87 “Getting Printer Information over the Network”.

rendezvous

Use the “rendezvous” command to display rendezvous-related settings.

❖ View settings
rendezvous settings are displayed.

msh> rendezvous

❖ Rendezvous service name setting
You can specify the rendezvous service name.

msh> rendezvous cname “computer name”

• The computer name can be entered using up to 63 alphanumeric charac-
ters.

❖ Rendezvous Installation location information setting
You can enter information about the location where the printer is installed.

msh> rendezvous location “location”

• Information about location can be entered using up to 32 alphanumeric
characters.

❖ Setting order of priority for each protocol

• diprint

msh> rendezvous diprint [0–99]

• ipp

msh> rendezvous ipp [0–99]
You can specify the order of priority for “diprint” and “ipp”. Smaller numbers
indicate higher priority.
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❖ IP TTL setting

msh> rendezvous ip ttl {1-255}
You can specify the IP TTL (the number of routers a packet can pass through). 

Note

❒ The default is 255.

❖ Resetting the computer name and location information
You can reset the computer name and location information.

msh> rendezvous clear {cname | location}

• cname
Reset the computer name. The default computer name will be displayed
when the computer is restarted.

• location
Reset the location information. The previous location information will be
deleted.

❖ Interface configuration

msh> rendezvous linklocal “interface_name”

• If many types of interface are installed, configure the interface that com-
municates with linklocal address.

• If you do not specify an interface, the Ethernet interface is automatically se-
lected.

• wlan can be specified only when the IEEE 802.11b interface is installed.

route

Use the “route” command to view and control the routing table.

❖ Specified route information display

msh> route get “destination”

• Specify the IP address to destination.
“0.0.0.0” cannot be specified as destination address.

❖ Enabling/disabling specified IP destination

msh> route active {host|net} “destination” {on | off}

• You can turn the specified destination on or off. Host becomes the default
setting.

Interface Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface
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❖ Adding IP Routing Table

msh> route add {host|net} “destination” “gateway”

• Adds a host or network route to “destination”, and a gateway address to
“gateway” in the table. 

• Specify the IP address to destination and gateway.

• Host becomes the default setting.

❖ Setting the Default IP Gateway

msh> route add default “gateway”

❖ Deleting specified IP destination from Routing Table

msh> route delete {host|net} “destination”

• Host becomes the default setting.

• IP address of destination can be specified.

❖ Route initialization

msh> route flush

Note

❒ The maximum number of routing tables is 16.

❒ Set a gateway address when communicating with devices on an external net-
work.

❒ The same gateway address is shared by all interfaces.

set

Use the “set” command to set the protocol information display “active” or “in-
active”.

❖ View settings
The following command displays protocol information (active/inactive).

msh> set tcpip

msh> set appletalk

msh> set netware

msh> set smb

msh> set protocol

• When protocol is specified, information about TCP/IP, AppleTalk, Net-
ware, SCSI print, and SMB appears.

msh> set ftp

msh> set rsh

msh> set diprint

msh> set web

msh> set snmp
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msh> set ssl

msh> set nrs

msh> set rfu

msh> set ipp

msh> set http

msh> set rendezvous

msh> set nbt

msh> set ssdp

❖ Configuration

• Enter “up”to enable protocol, and enter “down” to disable protocol.
You can set the protocol to “active” or “inactive”.

msh> set tcpip {up | down}

• If you disable TCP/IP, you cannot use remote access after logging off. If
you did this by mistake, you can use the control panel to enable remote ac-
cess via TCP/IP.

• Disabling TCP/IP also disables ftp, rsh, diprint, web, snmp, ssl, ipp, http,
rendezvous.

msh> set appletalk {up | down}

msh> set netware {up | down}

msh> set smb {up | down}

msh> set ftp {up | down}

msh> set rsh {up | down}

msh> set diprint {up | down}

msh> set web {up | down}

msh> set snmp {up | down}

msh> set nrs {up | down}

msh> set rfu {up | down}

msh> set ipp {up | down}

msh> set http {up | down}

msh> set rendezvous {up | down}

msh> set ssdp {up | down}

msh> set nbt {up | down}
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show

Use the “show” command to display network interface board configuration settings.

❖ View settings

msh> show

• If “-p” is added, you can view settings one by one.

Reference

p.95 “Configuring the Network Interface Board”

slp

Use “slp” command to view and configure SLP settings.

msh> slp ttl “ttl_val”

• You can search the NetWare server using SLP in the PureIP environment of
NetWare 5/5.1. Using the “slp” command, you can configure the value of
TTL which can be used by SLP multicast packet.

• The default value of TTL is 1. A search is executed only within a local seg-
ment. If the router does not support multicast, the settings are not available
even if the TTL value is increased.

• The acceptable TTL value is between 1 and 255.

smb

Use the “smb” command to configure or delete the computer or workgroup
name for SMB.

❖ Computer Name settings 

msh> smb comp “computer name”

• Set computer name using up to 15 characters. Names beginning with
“RNP” or “rnp” cannot be entered.

❖ Working Group Name settings

msh> smb group “work group name”

• Set workgroup name using up to 15 characters

❖ Comment settings

msh> smb comment “comment”

• Set comment using up to 31 characters.

❖ Notify print job completion

msh> smb notif {on | off}

• To notify print job completion, specify “on”. Otherwise, specify “off”
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❖ Deleting Computer Name

msh> smb clear comp

❖ Deleting Group Name

msh> smb clear group

❖ Deleting Comment

msh> smb clear comment

❖ View Protocol

msh> smb protocol 

snmp

Use the “snmp” command to display and edit SNMP configuration settings such
as the community name.

❖ View settings

msh> snmp

• Default access settings 1 is as follows:
Community name:public
IP address:0.0.0.0
IPX address:00000000:000000000000
Access type:read-only
Effective Protocol:IP/IPX

• Default access settings 2 is as follows:
Community name:admin
IP address:0.0.0.0
IPX address:00000000:000000000000
Access type:read-write
Effective Protocol:IP/IPX

• If “-p” is added, you can view settings one by one.

• To display the current community, specify its registration number.

❖ Display

msh> snmp ?

❖ Community name configuration

msh> snmp “number” name “community_name”

• You can configure ten SNMP access settings numbered 1-10.

• The printer cannot be accessed from SmartDeviceMonitor for Admin or
SmartDeviceMonitor for Client if “public” is not registered in numbers 1-
10. When changing the community name, use SmartDeviceMonitor for
Admin and SNMP Setup Tool to correspond with printer settings.

• The community name can be entered using up to 15 characters.
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❖ Deleting community name

msh> snmp “number” clear name

❖ Access type configuration

msh> snmp “number” type “access_type”

❖ Protocol configuration

msh> snmp {ip|ipx} {on|off}

• Use the following command to set protocols “active” or “inactive”: If you
set a protocol “inactive”, all access settings for that protocol are disabled.

• Specify “ip” for TCP/IP or “ipx” for IPX/SPX.

•  {on} means “active” and {off} means “inactive”.

• All protocols cannot be turned off concurrently.

❖ Configuration of protocol for each registration number

msh> snmp “number” active {ip|ipx} {on|off}

• To change the protocol of access settings, use the following command.
However, if you have disabled a protocol with the above command, acti-
vating it here has no effect.

❖ Access configuration

msh> snmp “number” {ip|ipx} “address”

• You can configure a host address according to the protocol used.

• The network interface board accepts requests only from hosts that have IP
addresses with access types of “read-only” or “read-write”. Enter “0” to
have network interface board accept requests from any host without re-
quiring a specific type of access.

• Enter a host address to deliver “trap” access type information to.

• To specify TCP/IP, enter “ip” followed by a space, and then the IP address.

• To specify IPX/SPX, enter “ipx” followed by a space, the IPX address fol-
lowed by a decimal, and then the MAC address of the network interface
board.

❖ sysLocation configuration

msh> snmp location

❖ Deleting sysLocation

msh> snmp clear location

Access type Type of access permission

no not accessible

read read only

write read and write

trap user is notified of trapmessages
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❖ sysContact setting

msh> snmp contact

❖ Deleting sysContact

msh> snmp clear contact

❖ SNMP v1v2 function configuration

msh> snmp v1v2 {on|off}

• Specify “on” to enable, and “off” to disable.

❖ SNMP v3 function configuration

msh> snmp v3 {on|off}

• Specify “on” to enable, and “off” to disable.

❖ SNMP TRAP configuration

msh> snmp trap {v1|v2|v3} {on|off}

• Specify “on” to enable, and “off” to disable.

❖ Remote Configuration Authorization configuration

msh> snmp remote {on|off}

• Specify “on” to enable, and “off” to disable the SNMP v1v2 setting.

❖ SNMP v3 TRAP configuration display

msh> snmp v3trap

msh> snmp v3trap {1-5}

• If a number from 1-5 is entered, settings are displayed for that number only.

❖ Configuring a sending address for SNMP v3 TRAP

msh> snmp v3trap {1-5} {ip|ipx} “address”

❖ Configuring a sending protocol for SNMP v3 TRAP

msh> snmp v3trap {1-5} active {ip|ipx} {on|off}

❖ Configuring a user account for SNMP v3 TRAP

msh> snmp v3trap {1-5} account “account_name”

• Enter an account name using up to 32 alphanumeric characters.

❖ Deleting an SNMP v3 TRAP user account

msh> snmp v3trap {1-5} clear account

❖ Configuring an SNMP v3 encryption algorithm

msh> snmp v3auth {md5|sha1}
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❖ Configuring SNMP v3 encryption

msh> snmp v3priv {auto|on}

• Set “auto” for automatic encryption configuration

• Set “on” for mandatory encryption configuration.

sntp

The printer clock can be synchronized with a NTP server clock using Simple
Network Time Protocol (SNTP). Use the “sntp” command to change SNTP set-
tings.

❖ View settings

msh> sntp

❖ NTP server address configuration
You can specify the IP address of the NTP server.

msh> sntp server “IP_address”

❖ Interval configuration

msh> sntp interval “polling_time”

• You can specify the interval at which the printer synchronizes with the op-
erator-specified NTP server. The default is 60 minutes.

• The interval can be entered from 0, or between 15 and 10,080 minutes.

• If you set 0, the printer synchronizes with the NTP server only when you
turn the printer on. After that, the printer does not synchronize with the
NTP server.

❖ Time-zone configuration

msh> sntp timezone “+/-hour_time”

• You can specify the time difference between the printer clock and NTP
server clock. The values are between –12:00 and +13:00.
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spoolsw

Use the “spoolsw” command to view and configure Job Spool settings.

You can only specify diprint, ipp, ftp, and smb(TCP/IP) protocol.

• The “spoolsw” command for configuring Job Spool settings is available only
when the optional hard disk is installed.

❖ View settings
The Job Spool setting appears.

msh> spoolsw

❖ Job Spool setting

msh> spoolsw spool {on|off}

Note

❒ Specify “on” to enable Job Spool, or “off” to disable it.

❖ Resetting Job spool setting

msh> spoolsw clear job {on|off}

• When the printer power is cut during job spooling, this determines wheth-
er to reprint the spooled job.

❖ Protocol configuration

msh> spoolsw diprint {on|off}
msh> spoolsw ipp {on|off}
msh> spoolsw smb {on|off}
msh> spoolsw ftp {on|off}

• You can specify the settings for diprint, ipp, ftp, and smb.

ssdp

Use the “ssdp” command to view and configure SSDP settings.

❖ View settings

msh> ssdp

❖ Setting effective time

msh> ssdp profile {1801–86400}
The default is 10800 seconds.

❖ Advertise packet TTL settings

msh> ssdp ttl {1–255}
The default is 4.
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status

Use the “status” command to display the printer status.

❖ view messages

msh> status

Reference

p.101 “System Log Information” 

syslog

Use the “syslog” command to display the information stored in the printer's sys-
tem log.

❖ View message

msh> syslog

Reference

p.101 “System Log Information”

upnp

Use the “upnp” command to display and configure the universal plug and play.

❖ Public URL display

msh> upnp url

❖ Public URL configuration

msh> upnp url "string"

• Enter the URL string in the character string.

❖ Deleting Public URL

msh> upnp clear url
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web

Use the “web” command to display and configure parameters on Web Image
Monitor.

❖ View Settings

msh> web

❖ URL Configuration
You can set URLs linked by clicking [URL] on Web Image Monitor.
Specify “1” or “2” for x as the number corresponding to the URL. Up to two
URLs can be registered and specified.

msh> web url http://”The URL or IP address you want to
register”/

❖ Resetting URLs registered as link destinations

msh> web x clear url
Specify “1” or “2” for x as the corresponding number to the URL.

❖ Link name configuration
You can enter the name for URL that appears on Web Image Monitor.
Specify “1” or “2” for x as the corresponding number to the link name.

msh> web name “Name you want to display”

❖ Resetting URL names registered as link destinations

msh> web x clear name
Specify “1” or “2” for x as the number corresponding to the link name.

❖ Help URL Configuration
You can set URLs linked by clicking [Help] or [?] on Web Image Monitor.

msh> web help http://”Help URL or IP address”/help/

❖ Resetting Help URL

msh> web clear help
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wiconfig

Use the “wiconfig” command to make settings for IEEE 802.11b.

❖ View settings

msh> wiconfig

❖ View IEEE 802.11b settings

msh> wiconfig cardinfo

• If IEEE 802.11b is not working correctly, its information is not displayed.

❖ Configuration

msh> wiconfig “parameter”

Parameter Value configured

mode [ap|adhoc|802.11adhoc] You can set the infrastructure mode(ap) , the 
802.11 Ad hoc mode (802.11adhoc), or the ad 
hoc mode (adhoc).

The default is ad hoc mode.

ssid “ID value” You can make settings for the SSID in the in-
frastructure mode.

Usable characters are ASCII 0x20-0x7e (32 
bytes).

An SSID value is set automatically to the 
nearest access point if no setting is made.

If no setting is made for the 802.11 ad hoc 
mode, the same value for the infrastructure 
mode or an ASSID value is automatically set. 
The default is blank.

channel frequency “channel no.” You can enable or disable the WEP function. 
To enable the WEP function, specify [on]; to 
disable it, specify [off].

To start the WEP function, enter the correct 
WEP key. The default is “11”.

enc [on|off] You can enable or disable the WEP function. 
To enable the WEP function, specify [on]; to 
disable it, specify [off].

To start the WEP function, enter the correct 
WEP key.
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key [ “key value” ] val [1|2|3|4] You can specify the WEP key when entering 
in hexadecimal.

With a 64-bit WEP, you can use 10 digit hex-
adecimals. With a 128-bit WEP, you can use 
26 digit hexadecimals.

Up to four WEP keys can be registered. Spec-
ify the number to be registered with “val”.

When a WEP is specified by key, the WEP 
specified by key phrase is overwritten.

To use this function, set the same key 
number and WEP key for all ports that trans-
mit data to each other. Put “0x”on the front 
of WEP key.

You can omit the numbers with “val”. The 
key number is set to 1 when making these 
omissions. The default is blank.

keyphrase [ “phrase” ] val [1|2|3|4] You can specify the WEP key when entering 
in ASCII.

With a 64-bit WEP, you can use10 digit hex-
adecimals. With a 128-bit WEP, you can use 
26 digit hexadecimals.

Up to four WEP keys can be registered. Spec-
ify the number to be registered with “val”.

When a WEP is specified by key phrase, the 
WEP specified by key is overwritten.

To use this function, set the same key 
number and WEP key for all ports that trans-
mit data to each other.

You can omit the numbers with “val”. The 
key number is set to1 when making these 
omissions. The default is blank.

encval [1|2|3|4] You can specify which of the four WEP keys 
is used for packet encoding. “1” is set if a 
number is not specified.

auth [open|shared] You can set an authorization mode when us-
ing WEP. The specified value and authorized 
mode are as follows:

open: open system authorized (default)

shared: shared key authorized rate

Parameter Value configured
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wins

Use the “wins” command to configure WINS server settings.

❖ Viewing settings

msh> wins

• If the IP address obtained from DHCP differs from the WINS IP address,
the DHCP address is the valid address.

❖ Configuration

msh> wins “interface_name” {on | off}

• {on} means “active” and {off} means “inactive”.

• Be sure to specify the interface.

• wlan can be specified only when the IEEE 802.11b interface is installed.

❖ Address configuration
Use the following command to configure a WINS server IP address:

msh> wins “interface_name” {primary|secondary} “IP ad-
dress”

• Use the “primary” command to configure a primary WINS server IP address.

• Use the “secondary” command to configure a secondary WINS server IP
address.

• Do not use “255.255.255.255” as the IP address.

rate [auto|11m|5.5m|2m|1m] You can set the IEEE 802.11b transmitting 
speed.

The speed you specify here is the speed at 
which data is sent. You can receive data at 
any speed.

auto: automatically set (default)

11m: 11 Mbps fixed

5.5m: 5.5 Mbps fixed

2m:2 Mbps fixed

1m: 1 Mbps fixed

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface

Parameter Value configured
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❖ NBT (NetBIOS over TCP/IP) Scope ID Selection
You can specify the NBT scope ID.

msh> wins “interface_name” scope “scope ID”

• The scope ID can be entered using up to 31 alphanumeric characters.

• Be sure to specify the interface.

• wlan can be specified only when the IEEE 802.11b interface is installed.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface
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SNMP

The SNMP agent operating on UDP and IPX is incorporated into the built-in Eth-
ernet board and optional IEEE 802.11b interface unit of this printer.

Using the SNMP manager, you can get information about the printer.

Important

❒ If you changed the machine's community name, change the configuration of
the connected computer accordingly, using SNMP Setup Tool. For details, see
SNMP Setup Tool Help.

The default community names are [public] and [admin]. You can get MIB infor-
mation using these community names.

❖ Start SNMP Setup Tool

• Windows 95/98/Me, Windows 2000, Windows NT 4.0:
Click the [Start] button.
Point to [SmartDeviceMonitor for Admin] on the [Programs] menu.
Click [SNMP Setup Tool].

• Windows XP:
Click the [Start] button.
Point to [SmartDeviceMonitor for Admin] on the [All Programs] menu.
Click [SNMP Setup Tool].

❖ Supported MIBs(SNMPv1/v2)

• MIB-II

• PrinterMIB

• HostResourceMIB

• RicohPrivateMIB

❖ Supported MIBs(SNMPv3)

• MIB-II

• PrinterMIB

• HostResourceMIB

• RicohPrivateMIB

• SNMP-FRAMEWORK-MIB

• SNMP-TARGET-MIB

• SNMP-NOTIFICATION-MIB

• SNMP-USER-BASED-SM-MIB

• SNMP-VIEW-BASED-ACM-MIB
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Getting Printer Information over the 
Network

This section explains details of each item displayed in the printer status and in-
formation.

This manual covers all models, and therefore contains functions and settings
that may not be available for your model.

Current Printer Status

The printer status can be checked using the following commands:

• UNIX: Use the “lpq” command and “rsh”, “rcp”, and “ftp” parameters. 

• mshell: Use the “status” command. 

Messages Description

Access Restricted The job was canceled because user have no authority. 

Add staples (Booklet: Back) The staple of booklet finisher (back) is exhausted. 

Add staples (Booklet: Both) The staple of booklet finisher is exhausted. 

Add staples (Booklet: Front) The staple of booklet finisher (front) is exhausted. 

Adjusting... The machine is initializing or calibrating. 

Call Service Center There is a malfunction in the machine.

Canceled The job is reset. 

Canceling Job... The job is being reset. 

Card/Counter not inserted The machine is waiting for prepaid card or key.

Coin or amount not inserted The machine is waiting for coin to be inserted.

Coin/Key Counter not inserted The machine is waiting for coin or key counter.

Configuring... Setting is being changed. 

Cooling Down Fusing Unit... The fusing unit is cooling down.

Cover Open: ADF The document feeder is open. 

Cover Open: Bridge Unit Left The cover of the left bridge unit is open.

Cover Open: Bridge Unit Right The cover of the right bridge unit is open.

Cover Open: Duplex Unit The cover of the duplex unit is open. 

Cover Open: Finisher The cover of Finisher is open. 

Cover Open: Finisher Front The front cover of Finisher is open. 

Cover Open: Finisher Rear The cover of the rear finisher is open.

Cover Open: Finisher Upper The upper cover of Finisher is open. 

Cover Open: Front Cover The front cover is open. 

Cover Open: Lower Right Cover The lower right cover is open. 
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Cover Open: Right Cover The right cover is open. 

Cover Open: Upper Right Cover The upper right cover is open. 

Data Size Error The data size error occurred. 

Empty: Black Toner The black toner cartridge is almost empty. 

Energy Saver Mode The machine is in Energy Saver Mode.

Error An error has occurred. 

Error: Address Book An error has occurred in the data of the address book. 

Error: Command Transmission An error has occurred in the machine. 

Error: DIMM Value A memory error occurred. 

Error: Ethernet Board An Ethernet board error has occurred.

Error: HDD Board A hard disk drive board error has occurred.

Error: Media Link Board An error has occurred on the media link board. 

Error: Memory Switch A memory switch error has occurred. 

Error: Optional Font An error has occurred in the font file of the machine. 

Error: Optional RAM An error has occurred in the optional memory unit.

Error: Parallel I/F Board An error has occurred in the parallel interface.

Error: PDL An error has occurred in the page description lan-
guage. 

Error: Rem. Certificate Renewal An error has occurred in the remote sever renewal. 

Error: USB Board An error has occurred in the USB interface board. 

Error: USB Interface An error has occurred in the USB interface. 

Error: Wireless Card Wireless card is not inserted during start up, or the 
IEEE 802.11b interface unit or the wireless card is tak-
en out after start up .

Error: Wireless Card or Board An error has occurred in the IEEE802.11b interface 
unit.

Exceed Booklet Stapling Limit The printing has exceeded the stapling limit of the 
booklet finisher.

Full: Finisher Finisher tray is full. 

Full: Finisher Booklet Tray Booklet tray of Finisher is full. 

Full: Finisher Shift Tray Shift tray of Finisher is full. 

Full: Finisher Shift Tray 1, 2 The shift tray 1 and 2 of Finisher are full. 

Full: Finisher Tray Finisher Tray is full. 

Full: Finisher Upper Tray Finisher's upper tray is full. 

Full: Hole Punch Receptacle Punch Chip receptacle for hole punch is full.

Full: Internal Shift Tray The internal shift tray is full. 

Full: Internal Tray 1 Internal tray 1 is full. 

Messages Description
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Full: Internal Tray 2 Internal tray 2 is full. 

Full: Waste Toner Waste toner is full.

Hex Dump Mode It is a hex dump mode. 

Immed. Trans. not connected It did not connect directly with the other party of the 
transmission. 

Immediate Transmission Failed An error has occurred while transmitting directly. 

In Use: Copier The copier is being used. 

In Use: Fax The fax is being used. 

In Use: Finisher Other functions is using Finisher. 

In Use: Input Tray Other functions is using the input tray. 

In Use: Staple Unit Other functions is using the staple unit. 

Independent-supplier Toner Toner that is not recommended is set. 

Key Card not inserted The machine is waiting for key card to be inserted.

Key Card/Counter not inserted The machine is waiting for key card or key counter to 
be inserted.

Key Counter not inserted The machine is waiting for key counter to be left in it.

Loading Toner... Toner is being supplied.

Low: Black Toner The black toner cartridge is not set correctly, or toner 
is almost running out.

Low: Toner The toner cartridge is not set correctly, or toner is al-
most running out.

Malfunction: Booklet Processor There is a problem with booklet finisher. 

Malfunction: Duplex Unit There is a problem with the duplex unit. 

Malfunction: Ext. Charge Unit There is a problem with the external charge unit.

Malfunction: Finisher There is a problem with the finisher. 

Malfunction: Interposer There is a problem with the interposer. 

Malfunction: Output Tray There is a problem with the output tray. 

Malfunction: Staple Unit There is a problem with the staple unit. 

Malfunction: Tray 1 There is a problem with tray 1. 

Malfunction: Tray 2 There is a problem with tray 2. 

Malfunction: Tray 3 There is a problem with tray 3. 

Malfunction: Tray 3 (LCT) There is a problem with tray 3 (LCT). 

Malfunction: Tray 4 There is a problem with tray 4. 

Memory Low: Copy Memory shortage has occurred while the copy was 
operating. 

Memory Low: Data Storage Memory shortage has occurred while the document 
was being accumulated. 

Messages Description
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Memory Low: Fax Scanning Memory shortage has occurred while transmitting the 
fax. 

Memory Low: Scanning Memory shortage has occurred while the scanner was 
working. 

Miscellaneous Error Other error has occurred. 

Mismatch: Paper Size Indicated paper tray does not contain paper of select-
ed size.

Mismatch: Paper Size and Type Indicated paper tray does not contain paper of select-
ed size and type.

Mismatch: Paper Type Indicated paper tray does not contain paper of select-
ed type.

Near Replacing: Black PCU Prepare the new black photoconductor unit. 

Near Replacing: Develop. Unit K Prepare the new development unit (black). 

Near Replacing: Fusing Unit Prepare the new fusing unit. 

Nearly Full: Waste Toner Waste toner bottle is nearly full.

Need more Staples Stapler has almost run out of staples.

No Paper: Interposer Tray There is no paper in interposer unit. 

No Paper: Selected Tray There is no paper in specified tray. 

No Paper: Tray 1 There is no paper in tray 1. 

No Paper: Tray 2 There is no paper in tray 2. 

No Paper: Tray 3 There is no paper in tray 3. 

No Paper: Tray 3 (LCT) There is no paper in tray 3 (Large Capacity tray). 

No Paper: Tray 4 There is no paper in tray 4. 

Not Detected: B2 Lever B2 lever is not correctly set. 

Not Detected: Black Toner Black toner is not correctly set. 

Not Detected: Develop. Unit (K) The development unit (black) is not correctly set. 

Not Detected: Duplex Feed Unit The duplex unit is not correctly set. 

Not Detected: Duplex Unit The duplex feed unit is not correctly set. 

Not Detected: Finisher Finisher is not correctly set. 

Not Detected: Fusing Unit The fusing unit is not correctly set. 

Not Detected: Input Tray The paper feed tray is not correctly set. 

Not Detected: Interposer Interposer unit is not correctly set. 

Not Detected: PCU The photoconductor unit is not correctly set. 

Not Detected: PCU (K) The photoconductor unit (black) is not correctly set. 

Not Detected: Tray 1 Tray 1 is not correctly set. 

Not Detected: Tray 2 Tray 2 is not correctly set. 

Not Detected: Tray 3 Tray 3 is not correctly set. 

Messages Description
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Not Detected: Tray 3 (LCT) The large capacity tray (tray 3) is not correctly set.

Not Detected: Tray 4 Tray 4 is not correctly set. 

Not Detected: WasteToner Bottle Waste toner bottle is not correctly set. 

Not Reached, Data Deleted Unreached job is deleted. 

Not Reached, Data Stored Unreached job is stored. 

Offline Printer is offline. 

Original on Exposure Glass The original remains on the exposure glass. 

Panel Off Mode The machine is in Panel-Off mode.

Panel Off Mode>>Printing ava. The machine is in Control Panel-Off mode.

Paper in Duplex Unit The paper remains in the duplex unit. 

Paper in Finisher The paper remains in Finisher. 

Paper Misfeed: ADF The paper has jammed in Document Feeder. 

Paper Misfeed: Duplex Unit The paper has jammed in the duplex unit. 

Paper Misfeed: Finisher The paper has jammed in Finisher. 

Paper Misfeed: Input Tray The paper has jammed in the input tray. 

Paper Misfeed: Internal/Output The paper has jammed inside the machine. 

Paper on Finisher Shift Tray 2 The paper remains in Finisher Shift Tray 2. 

Paper on FinisherShiftTray1, 2 The paper remains in Finisher Shift Tray 1 and 2. 

Prepaid Card not inserted The machine is waiting for prepaid card to be inserted.

Print Complete The print was completed. 

Printing... Printing is in progress.

Processing Data is being processed. 

Proxy Address/Port Incorrect The proxy address and port setting is incorrect.

Proxy User/Password Incorrect The proxy user name and password setting is incorrect.

RC Gate Connection Error Failed connection with RC Gate. 

Ready The machine is ready to print.

Renewing Remote Certificate The remote certificate is being renewed.

Replace Black PCU It is time to replace the black photoconductor unit. 

Replace Charger Kit It is time to replace the charger kit. 

Replace Cleaning Web It is time to replace the Cleaning Web. 

Replace Develop. Unit It is time to replace the development unit. 

Replace Develop. Unit (Black) It is time to replace the development unit (black). 

Replace Fusing Unit It is time to replace the fusing unit. 

Replace PCU It is time to replace the photoconductor unit. 

Replace Transfer Belt It is time to replace the transfer belt. 

Messages Description
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Note

❒ For details about UNIX commands, see UNIX Supplement.

❒ Check the error contents that may be printed in the configuration page. For
details about printing a configuration page, see Printer Reference.

Replace Transfer Cleaning Unit It is time to replace the transfer cleaning unit. 

SD Card Authentication failed SD card authentication failed.

Setting Remotely The RDS setting is being processed. 

Skipped due to Error Skipped the error. 

Storage Complete The storage is complete.

Storage Failed The storage has failed.

Supplies Order Call failed The supply order call has failed. 

Suspend / Resume Key Error Finisher stop button was pressed.

Transmission Aborted The transmission was interrupted. 

Transmission Complete The transmission completion was completed. 

Transmission Failed The transmission has failed.

Tray Error: Chaptering The paper feed tray specification error has occurred 
because chaptering as well as the normal paper use 
the same tray for printing.

Tray Error: Duplex Printing Selected paper tray cannot be used for duplex printing.

Unit Left Open: ADF Document feeder is opened.

Warming Up... The machine is warming up.

Messages Description
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Printer configuration

You can check the printer configuration using telnet.

This section explains the checking procedure for input/output tray and printer
language.

• UNIX: Use the “info” command and “rsh”, “rcp”, and “ftp” parameters. 

• mshell: Use the “info” command. 

❖ Input Tray

❖ Output Tray

❖ Printer Language

Note

❒ For details about UNIX commands and parameters, see UNIX Supplement.

Item Description

No. ID number of the paper tray

Name Name of the paper tray

PaperSize Size of paper loaded in the paper tray

Status Current status of the paper tray

• Normal:Normal

• NoInputTray: No tray

• PaperEnd:No paper

Item Description

No. ID number of the output tray

Name Name of the output tray

Status Current status of the output tray

• Normal:Normal

• PaperExist:Paper exist

• OverFlow:Paper is full

• Error:Other errors

Item Description

No. ID number of the printer language used by the 
printer

Name Name of the printer language used in the 
printer

Version Version of the printer language
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Understanding the Displayed Information 

This section explains how to read status information returned by the network in-
terface board.

Print Job Information

Use the following command to display print job information:

• UNIX: Use the “info” command and “rsh”, “rcp”, and “ftp”, parameters. 

• mshell: Use the “info” command. 

Note

❒ For details about UNIX commands and parameters, see UNIX Supplement.

Print Log Information

This is a record of the most recent jobs printed.

Use the following command to display print log information:

• UNIX: Use the “prnlog” command and “rsh”, “rcp”, and “ftp”, parameters. 

• telnet : Use the “prnlog” command.

Item Description

Rank Print job status.

• Active
Printing or preparing for printing.

• Waiting
Waiting to be transferred to the printer.

Owner Print request user name.

Job Print request number.

Files The name of the document.

Total Size The size of the data (spooled).

The default is 0 bytes.

Item Description

ID Print request ID.

User Print request user name.

Page Number of pages printed
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Note

❒ For details about UNIX commands and parameters, see UNIX Supplement.

Configuring the Network Interface Board

Use the following command to display network interface board settings:

• telnet : Use the “show” command.

Result Print Request Result

Communication Result

• OK
Print was completed normally. However, the print result may 
not be as required due to printer problems.

• NG
Printing was not completed normally.

• Canceled
An “rcp“, or “rsh“ command print request was canceled, pos-
sibly due to the printing application. Not applicable to the 
“ftp” or “rprinter”command. 

Time Time the print requested was received.

Time of print request reception

User ID Printer driver-configured User ID.

Appears when the print request ID is specified.

JobName Name of the document for printing

Appears when the print request ID is specified.

Item Description

Common

Mode 

Protocol Up/Down Protocol Settings

 AppleTalk 

 TCP/IP 

 Netware 

 SMB

 SCSI print

Device Up/Down Device Settings

Parallel

USB

Bluetooth

Ethernet interface

Syslog priority

Item Description
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NVRAM version 

 Device name 

 Comment 

 Location 

 Contact 

 Soft switch 

 AppleTalk AppleTalk settings

 Mode 

 Net 

 Object 

 Type 

 Zone 

 TCP/IP TCP/IP settings

Mode

ftp 

rsh 

telnet 

diprint 

web 

http

ftpc 

snmp

ipp

autonet

rendezvous

ssl

nrs

rfu

nbt

ssdp

 EncapType 

DHCP

 Host name

Address

Network

Item Description
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Broadcast

 DNS Domain

Gateway Access Control settings

AccessRange[X] X can be set between 1 and 5.

Time server Time settings

Time Zone

Time server polling time

SYSLOG server Websys settings

Home page URL[1] 

Home page linkname[1]

Home page URL[2] 

Home page linkname[2] 

Help page URL

 Netware 

 EncapType 

 RPRINTER number 

 Print server name 

 File server name

 Context name 

 Switch 

 Mode 

 NDS/Bindery 

 Packet negotiation 

 Login Mode

 Print job timeout 

 Protocol

 SAP interval time

 NDS Tree Name

Transfer Protocol

 SMB SMB settings

 Switch 

 Mode 

 Direct print 

 Notification 

 Workgroup name 

Item Description
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 Computer name 

 Comment 

 Share name[1] 

 Protocol

SCSI print

Bidi

IEEE 802.11b IEEE 802.11b settings

Host Name

DHCP

Address

Network

Broadcast

BDNS Domain

Communication Mode

SSID

Channel range

Channel

Authentication

TX Rate

Encyption key

DNS DNS settings

 Server[X] X can be set between 1 and 3.

Selected DNS Server

SMTP

Server name

Port number

Domain Name

ether

wlan

DDNS

ether

wlan

Item Description
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WINS WINS settings

ether

Primary WINS

Secondary WINS

wlan

Primary WINS

Secondary WINS

Bluetooth Bluetooth settings

Bluetooth mode Bluetooth connection mode

SSDP SSDP settings

UUID

Profile

TTL

UPnP UPnP settings

URL

Rendezvous Rendezvous settings

 Computer Name (cname)

 Local Hostname<ether>

 Local Hostname<wlan>

 Location

 Priority <diprint>

Priority <ipp>

IP TTL

LinkLocal Route for Multi I/F

SNMP SNMP settings

SNMPv1v2

SNMPv3

protocol

v1Trap

v2Trap

v3Trap

SNMPv1v2 Remote Setting

SNMPv3 Privacy

Item Description
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AuthFree Authfree settings

AuthFreeEntry[X] X can be set between 1 and 5.

Parallel

USB

Shell mode Remote maintenance tool mode

Item Description
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Message List

This is a list of messages that appear in the machine's system log. The system log
can be viewed using the “syslog” command.

System Log Information

Use the following command to display the system log information:

• UNIX: Use the “syslog” command and “rsh”, “rcp”, and “ftp” parameters. 

• telnet : Use the “syslog” command. 

Message Problem and solutions

Access to NetWare server <file server name> 
denied. Either there is no account for this print 
server on the NetWare server or the password 
was incorrect. 

(In the print server mode) Login to the file 
server failed. Make sure that the print server is 
registered on the file server. If a password is 
specified for the print server, delete it.

account is unavailable:

Same account name be used.

User account is disabled. This could be be-
cause it use the same account name as the ad-
ministrator account.

account is unavailable:

The authentication password is not set up.

User account is disabled. This could be be-
cause the authentication password is not set, 
and only the encryption account is set.

account is unavailable: encryption is impossi-
ble.

Encryption is not possible and account is disa-
bled. This could be because:

• Security option is not installed.

• Encryption password has not been speci-
fied.

add_sess: bad trap <IP address>community 
<community name>

The IP address (0.0.0.0.) is unavailable when 
the community access type is TRAP. Specify 
the host IP address for the TRAP destination.

add_sess: community<community name> al-
ready defined.

The same community name already exists. 
Use another community name.

add_sess_ipx: bad trap<IPX address>commu-
nity <community name>

The IPX address (00:00:00:00:00:00) is unavail-
able when the community access type is 
TRAP. Specify the host IPX address for the 
TRAP destination.

add_sess_ipx: community <community 
name> already defined.

The same community name already exists. 
Use another community name.

Attach FileServer= <file servername> Connection to the file server as the nearest 
server has been established.

Attach to print queue <print queue name> (In the print server mode) Attached to the 
print queue.

btd is disabled. Communication via Bluetooth is unavailable 
because btd is disabled in the security mode.

 Enable the btd in the security mode.
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centrod is disabled. Communication via parallel connection is un-
available because centrod is disabled in the se-
curity mode.

Enable centrod in the security mode.

Cannot create service connection (In the remote printer mode) Connection to the 
file server has not been established. The 
number of file server users may have exceeded 
the maximum capacity of the file server.

Cannot find rprinter (<print server 
name>/<printer number>)

The printer with the number displayed on the 
print server does not exist. Make sure that the 
printer number is registered on the print server.

Change IP address from DHCP Server. The IP address changes when DHCP lease is re-
newed. To always assign the same IP address, 
set a static IP address to the DHCP server.

child process exec error! (process name) The network service failed to start. Turn the 
printer off and then on. If this does not work, 
contact your service or sales representative.

Connected DHCP Server(<DHCP serverad-
dress>).

The IP address was successfully received from 
the DHCP server.

connection from <IP address> Login was from the host IP address.

Could not attach to FileServer<error number> (In the remote printer mode) Connection to the 
file server has not been established. The file 
server has refused the connection. Check the 
file server configuration.

Could not attach to PServer<print server> (In the remote printermode) Connection to the 
print server has not been established. The 
print server has refused the connection. Check 
the print server configuration.

Current Interface Speed:xxxMbps Speed of the network (10Mbps, 100 Mbps, or 
1Gbps).

Current IP address <current IP address> Current IPv4 address.

Current IPX address<IPX address> Current IPX address

DHCP lease time expired. DHCP lease time has expired. The printer tries 
to discover the DHCP server again. The IP ad-
dress until now becomes invalid.

DHCP server not found. The DHCP server was not found. Make sure 
that the DHCP is on the network.

dhcpcd start. The DHCPCD service (dhcp client service) has 
started.

dpsd is disabled. Communication via PictBridge is unavailable 
because PictBridge is disabled in the security 
mode. Enable PictBridge in the security mode.

Duplicate IP=<IP address>(from<MAC ad-
dress>).

The same IP address was used. Each IP ad-
dress must be unique. Check the address of the 
device indicated in [MAC address].

Message Problem and solutions
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Established SPX Connection with PServer, 
(RPSocket=<socketnumber>, connID=<con-
nection ID>)

(In the remote printer mode) Connection to the 
print server has been established.

exiting The lpd service has ended and the system is 
exiting the process.

Exit pserver (In the print server mode) The print server 
function is disabled because the necessary 
print server settings have not been made.

Frametype =<frame typename> The frame type name is configured to be used 
on NetWare.

httpd start. The httpd service has started.

inetd start. The inetd service has started.

< Interface >: Subnet overlap. The same IP address and the subnet mask is 
used with other device.

IPP cancel-job: permission denied. The printer could not authenticate the name of 
the user attempting to cancel a job.

IPP job canceled. jobid=%d. The spooled job was canceled due to error or 
user request.

LeaseTime=<lease time>(sec), Renew-
Time=<renewtime>(sec).

The resource lease time received from the 
DHCP server is displayed in [lease time] in 
seconds. The renewal time is displayed in [re-
new time] in seconds.

Login to fileserver <file server name> 
(<IPX|IP>,<NDS|BINDERY>) 

(In the print server mode) Login to the file 
server is in the NDS or BINDERY mode.

Memory allocate error. Data cannot be obtained. 

Disconnect the USB cable, and then connect it.

Name registration success. WINS Serv-
er=<WINS server address> NetBIOS 
Name=<NetBIOS name> 

Name registration of <NetBIOS Name> to 
<WINS server address> was successful.

Name registration success in Broadcast 
name=<NetBIOS Name> 

Name registration by Broadcast name of <Net-
BIOS Name> was successful.

Name registration failed. name=<NetBIOS 
name> 

Name registration of <NetBIOS Name> failed. 
Change to different NetBIOS name. 

nbtd start. The nbtd service has started.

nprinter start (Netware) (In the remote printer mode) The NetWare 
service has started.

nwstart start. (NetWare) The service for NetWare protocol stack setting 
has started.

Open log file <file name> (In the print server mode) The specified log file 
has been opened.

papd start. (AppleTalk) The AppleTalk print service has started.

Message Problem and solutions
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phy release file open failed. Replacing the network interface board is re-
quired. Contact your sales or service repre-
sentative.

Print queue <print queue name> cannot be 
serviced by printer 0, <print server name>

(In the print server mode) The print queue 
cannot be established. Make sure that print 
queue exists on the specified file server.

Print server <print servername>has no printer. (In the print server mode) The printer is not as-
signed to the print server. Using NWadmin, 
assign the printer, and then restart it. 

print session full No more print jobs can be accepted.

Printer <printer name> has no queue (In the print server mode) The print queue is 
not assigned to the printer. Using NWadmin, 
assign the print queue to the printer, and then 
restart it.

pserver start. (NetWare) (In the print server mode) The NetWare serv-
ice has started.

Required file server (<file servername>) not 
found

The required file server is not found.

restarted. The lpd service has started.

sap enable, saptype=<SAP type>, sap-
name=<SAP name>

The SAP function has started. The SAP packet 
is issued to advertise the service on the SAP ta-
ble on the NetWare server.

session <community name> not defined. The requested community name is not de-
fined.

session_ipx <community name> not defined. The requested community name is not de-
fined.

Set context to <NDS contextname> An NDS context name has been set.

shutdown signal received. network service re-
booting...

The network service is rebooting.

smbd start. (NETBIOS) The smbd service has started.

SMTPC: failed to get smtp server ip-address. The SMTP server IP address could not be ob-
tained. This could be because:

• The specified DNS server could not be 
found.

• No connection to the network has been es-
tablished.

• The specified DNS server could not be 
found.

• An incorrect DNS server is specified.

• The specified SMTP server IP address 
could not be found in the DNS server.

Message Problem and solutions
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SMTPC: failed to connect smtp server. time-
out.

Connection to the SMTP server failed due to 
timeout. This could be because the specified 
SMTP server name is incorrect, or no connec-
tion to the network has been established, or the 
network configuration is incorrect, so there is 
no response from the SMTP server. Check the 
SMTP server name, or the network connection 
and configuration. 

SMTPC: refused connect by smtp server. Connection to the SMTP server is denied. This 
could be because server other than the SMTP 
server has been specified, or the specified 
SMTP server port number is incorrect. Check 
the SMTP server name, port number, or the 
SMTP server port number.

SMTPC: no smtp server. connection close. Connection to the SMTP server failed due to 
no response from SMTP. This could be be-
cause a server other than the SMTP server has 
been specified, or the specified SMTP server 
port number is incorrect. Check the SMTP 
server name, port number, or the SMTP server 
port number.

SMTPC: failed to connect smtp server. Connection to the SMTP server failed. This 
could be because no connection to the network 
has been established, or the network configu-
ration is incorrect, so there is no response from 
the SMTP server, or the specified SMTP server 
name is incorrect, or the specified SMTP server 
IP address could not be found in the DNS serv-
er, or a server other than the SMTP server has 
been specified, or the specified SMTP server 
port number is incorrect. Check the DNS Serv-
er's IP address and SMTP server's IP address, 
or the SMTP server name and SMTP port 
number, or the SMTP server's SMTP port 
number, or the network connection and con-
figuration.

SMTPC: username or password wasn’t cor-
rect. [response code] (information)

Connection to the SMTP server failed, because 
the specified SMTP user name is incorrect, or 
the specified SMTP password is incorrect. 
Check the SMTP user name and password.

Snmp over IP is ready Communication over TCP/IP with snmp is 
available.

Snmp over ipx is ready. Communication over IPX with snmp is availa-
ble.

snmpd start. The snmpd service has started.

started. The direct print service has started.

Started. The rendezvous function is enabled.

terminated. The rendezvous function is disabled.

Message Problem and solutions
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Note

❒ For details about UNIX commands and parameters, see UNIX Supplement.

The print server received error <error 
number> during attempt to log in to the net-
work. Access to the network was denied. Ver-
ify that the print server name and password 
are correct. 

Login to the file server failed. The print server 
is not registered or a password is specified. 
Register the print server without specifying a 
password.

too many pictures. PictBridge printing failed because too many 
image are sent during one print transaction. 
Reduce images at one print transaction.

trap account is unavailable. v3Trap cannot be sent. This could be because 
the Trap destination account is different from 
the account specified by the printer.

usbd is disable. Plug and Play function and printing is disa-
bled because usbd is disabled in the security 
mode.

Enable usbd in the security mode.

WINS name registration: No response to serv-
er<WINS server address>

There was no response from the WINS server. 
Check the correct WINS server address is en-
tered. Alternatively, check the WINS server is 
functioning properly. 

WINS wrong scopeID=<Scope ID> An invalid scope ID was used. Use a valid 
scope ID.

Message Problem and solutions
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3. Special Operations under
Windows

Printing Files Directly from Windows

You can print files directly using Windows commands. For example, you can
print PostScript files for PostScript 3.

❖ Windows 95/98/Me
You can print files directly using ftp command.

❖ Windows 2000/XP, Windows Server 2003, Windows NT 4.0
You can print files directly using rcp and ftp command.

Setup

Follow the procedure below to make network environment settings.

A Enable TCP/IP with the control panel, and then set up the printer’s network
environment about TCP/IP including IP addresses.

TCP/IP of the printer is set as default.

B Install a TCP/IP in Windows to set up the network environment.

Consult the network administrator for the local setting information.

C To print under Windows 2000/XP or Windows Server 2003, install “Printing
service for UNIX” as the network application. To print under Windows NT
4.0, install “Microsoft TCP/IP printing” as the network application.

Reference

For details about setting the IP address of the printer using DHCP, see
p.114 “Using DHCP”

Using a Host Name Instead of an IP Address

When a host name is defined, you can specify a printer by host name instead of
IP address. The host names vary depending on the network environment.

When using DNS

Use the host name set to the data file on the DNS server.

When setting the IP address of a printer using DHCP

Use the printer name on the configuration page as the host name.

Note

❒ For details about printing a configuration page, see General Setting Guide.
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In other cases

Add the IP address and host name of the network printer to the hosts file on the
computer used for printing. Methods of addition vary depending on operating
systems.

Windows 95/98/Me

A Copy \WINDOWS\HOSTS.SAM to the same directory and name it
“HOSTS” with no extension.

B Open the "\WINDOWS\HOSTS" file created using memo pad files, for in-
stance.

C Add an IP address and host name to the hosts file using the following for-
mat:

192.168.15.16  host  # NP

“192.168.15.16” is the IP address, “host” is the printer's host name, and “#NP”
is replaced by comments. Insert a space or tab between “192.168.15.16” and
“host”, between “host” and “#NP” respectively, using one line for this for-
mat.

D Save the file.

Windows 2000/XP, Windows Server 2003, Windows NT 4.0

A Open the hosts file using memo pad files, for instance.

The hosts file is in the following folder:

\WINNT\SYSTEM32\DRIVERS\ETC\HOSTS

“\WINNT” is the directory of the installation destination for Windows
2000/XP, Windows Server 2003, and Windows NT 4.0.

B Add an IP address and host name to the hosts file using the following for-
mat:

192.168.15.16  host  # NP

“192.168.15.16” is the IP address, “host” is the printer's host name, and “#NP”
is replaced by comments. Insert a space or tab between “192.168.15.16” and
“host”, between “host” and “#NP” respectively, using one line for this for-
mat.

C Save the file.
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Printing Commands

The following explains printing operations using the “rcp”, and “ftp” commands.

Enter commands using the command prompt window. The location of the com-
mand prompts varies depending on operating systems:

• Windows 95/98
 [Start] - [Programs] - [MS-DOS Prompt] 

• Windows Me
 [Start] - [Programs] - [Accessories] - [MS-DOS Prompt] 

• Windows 2000
 [Start] - [Programs] - [Accessories] - [Command Prompt] 

• Windows XP, Windows Server 2003
 [Start] - [All Programs] - [Accessories] - [Command Prompt] 

• Windows NT 4.0
 [Start] - [Programs] - [Command Prompt] 

Note

❒ Match the data format of the file to be printed with the emulation mode of the
printer.

❒ If the message “print requests full” appears, no print jobs can be accepted. Try
again when sessions end. For each command, the amount of possible sessions
is indicated as follows:

• rcp, rsh: 5

• ftp: 3

❒ Enter the file name in a format including the path from the directory execut-
ing commands.

❒ The “option” specified in a command is an intrinsic printer option and its syn-
tax is similar to printing from UNIX. For details, see UNIX Supplement.

rcp

First, register the printer's host name in the hosts file.

c:> rcp [-b] \pass name\file name [pass name\file name...]
printer's host name:[option]

Note

❒ In file names, “*” and “?” can be used as wild cards.

❒ When printing a binary file, add the “-b” option.

When using a printer with the host name “host” to print a PostScript file named
“file 1” or “file 2” located in the “C:\PRINT” directory, the command line is as fol-
lows:

c:> rcp -b C:\PRINT\file1 C:\PRINT\file2 host:filetype=RPS
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Reference

For details about registering the printer's host name in the hosts file, see p.107
“Using a Host Name Instead of an IP Address”

ftp

Use the “put” or “mput” command according to the number of files to be printed.

❖ When one file is printed

ftp> put \pass name\file name [option]

❖ When multiple files are printed

ftp> mput \pass name\file name [\pass name\file name...]
[option]

Follow the procedure below to print using the “ftp” command.

A Formulate the printer's IP address or the host name of the hosts file printer
as an argument and use the "ftp" command.

% ftp printer's IP address

B Enter the user name and password, and then press the {# Enter} key.

For details about the user name and password, consult your network admin-
istrator.

User:
Password:

When user authentication is set, enter a login user name and password.

CWhen printing a binary file, set the file mode to binary.

ftp> bin

When printing a binary file in ASCII mode, print may not come out correctly.

D Specify files to be printed.

The following shows the examples of printing a PostScript file named “file 1”
in the “C:\PRINT” directory and printing file 1 and file 2.

ftp> put C:\PRINT\file1 filetype=RPS
ftp> mput C:\PRINT\file1 C:\PRINT\file2

E Quit ftp.

ftp> bye

Note

❒ “=”, “,”, “_”, and “;”cannot be used for filenames. File names will be read
as option strings.

❒ For “mput” command, option can not be defined.

❒ For “mput” command, “*” and “?” can be used as wild cards in file names.

❒ When printing a binary file in ASCII mode, print may not come out correctly.
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4. Appendix

When Using Windows Terminal Service / 
MetaFrame

The following explains how to use Windows Terminal Service and Maintenance.

Operating Environment

The following operating systems and MetaFrame versions are supported.

❖ Windows NT Server 4.0 Terminal Server Edition

• MetaFrame 1.8 SP3 / FR1+SP3 / SP4

• MetaFrame XP 1.0 SP1 / SP2 / FR1

❖ Windows 2000 Server / Advanced Server

• MetaFrame 1.8 SP3 / FR1+SP3 / SP4

• MetaFrame XP 1.0 SP1 / SP2 / SP3 / FR1 / FR2 / FR3

• MetaFrame Presentation Server 3.0

• Citrix Presentation Server 4.0

❖ Windows 2003 Server

• MetaFrame XP 1.0 FR3

• MetaFrame Presentation Server 3.0

• Citrix Presentation Server 4.0

Supported Printer Drivers

❖ When Windows Terminal Service is operating

• PCL drivers

• PostScript 3

• RPCS drivers

Note

❒ Some RPCS printer driver functions do not work if Windows Terminal Serv-
ice is installed.
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Limitations

The following limitations apply to the Windows Terminal Service environment.

These limitations are built in Windows Terminal Service or MetaFrame.

❖ Windows Terminal Service
In the Windows Terminal Service environment, some of the printer driver’s
functions is unavailable. In an environment where Windows Terminal Serv-
ice is installed, some of the printer driver’s functions is unavailable, even if
any function of Windows Terminal Service is not used. When you install
SmartDeviceMonitor for Client in an environment where the Terminal Serv-
ice is running on a Windows NT Server 4.0 Terminal Server Edition or the
Windows 2000 Server family computer, be sure to install it using the install
mode. The following are the two methods of installation using the install
mode:

A Use [Add/Remove Programs] in [Control Panel] to install SmartDeviceMonitor
for Client.

B Enter the following command in the MS-DOS command prompt:
To quit the install mode, enter the following command in the MS-DOS com-
mand prompt.

❖ MetaFrame's [Auto-creating client printers] 
Using [Auto-creating client printers] can select a logical printer created by copy-
ing the client's local printer data to the MetaFrame server. We strongly recom-
mend testing this function in your network environment before using it for
your work.

• The settings for optional equipment will not be stored in the server after
the equipment is disconnected. The settings for optional equipment will be
restored to its defaults each time the client computer logs on to the server.

• When printing a large number of bitmap images or using the server in a
WAN environment over dial-up lines such as ISDN, printing may not be
possible or errors may occur, depending on data transfer rates.

• When using MetaFrame XP 1.0 or higher versions, we recommend making
settings in [Client Printer bandwidth] under [Citrix Management Console] accord-
ing to the environment.

• If a print error occurs on the server and the print job or a printer created in
[Auto-creating client printers] cannot be deleted, we recommend the follow-
ing:

• MetaFrame 1.8 SP3, MetaFrame XP 1.0 SP1/FR1
Make settings in [Delete unfinished print jobs] in the registry. For details,
see the Readme file provided with MetaFrame.

• MetaFrame XP 1.0 FR2
Make settings in [Delete pending print jobs at logout] under [Printer Proper-
ties Management] of Citrix Management Console.



When Using Windows Terminal Service / MetaFrame

113

4

❖ MetaFrame's [Printer driver replication] 
Using [Printer driver replication] can distribute printer drivers across all servers
in a server farm. We strongly recommend testing this function in your net-
work environment before using it for your work.

• If the printer drivers are not properly copied, install them directly onto
each server.
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Using DHCP

You can use the printer in a DHCP environment. You can also register the print-
er NetBIOS name on a WINS server when it is running.

❖ When a static IP address is set for both interfaces

• IP Address: If interface IP addresses overlap, the Ethernet interface is se-
lected.

• Subnet Mask: If interface subnet masks overlap, the Ethernet interface is
selected.

• Gateway Address: The selected value is applied.

Note

❒ Make the gateway address setting inside the subnet set in the interface. 

❒ If a value is beyond the range of the subnet selected by the interface, the
machine operates using “0.0.0.0”.

❖ When obtaining addresses from the DHCP server

• IP Address, Subnet Mask: you can configure addresses assigned by a
DHCP server. If IP addresses overlap or the same subnet IP addresses are
selected, the effective value is assigned only to the prioritized interface.
Ethernet has default interface priority.

• AutoNet: A temporary IP address starting with 169.254 and not used on
the network, is assigned to the prioritized interface.

• Gateway Address, DNS Server Address, and Domain Name: You can con-
figure the addresses assigned by DHCP to the prioritized interface.
If the gateway address is beyond the range of the subnet selected for the
interface, the machine operates using “0.0.0.0”.
Ethernet has default interface priority.

❖ When there are static IP addresses and addresses assigned by DHCP

• IP Address and subnet mask: if a static IP address is the same as an address
assigned by DHCP, or the static subnet mask address and the subnet mask
address assigned by DHCP overlap, the machine uses the static IP address
interface. The interface with the DHCP setting is set by default.

• Gateway Address: operates using the address entered manually.
If a static address is not selected, or is set to 0.0.0.0, the interface using the
address assigned by DHCP is used.
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Note

❒ Printers that register the printer NetBIOS name on a WINS server must be
configured for the WINS server.

❒ Supported DHCP servers are Microsoft DHCP Server included with Win-
dows 2000 Server, Windows Server 2003, and Windows NT 4.0, and the
DHCP server included with NetWare and UNIX.

❒ If you do not use the WINS server, reserve the printer's IP address in the
DHCP server so the same IP address is assigned every time.

❒ To use the WINS server, change the WINS server setting to “active” using the
control panel.

❒ Using the WINS server, you can configure the host name via the remote net-
work printer port.

❒ DHCP relay-agent is not supported. If you use DHCP relay-agent on a net-
work via ISDN, it will result in increased line charges. This is because your
computer connects to the ISDN line whenever a packet is transferred from the
printer.

❒ If there is more than one DHCP server, use the same setting for all servers.
The machine operates using data from the DHCP server that responds first.

Using AutoNet

If the printer IP address is not automatically assigned by the DHCP server, a
temporary IP address starting with 169.254 and not used on the network can be
automatically selected by the printer.

Note

❒ The IP address assigned by the DHCP server is given priority over that select-
ed by AutoNet.

❒ You can confirm the current IP address on the configuration page. For more
information about the configuration page, see General Settings Guide.

❒ When AutoNet is running, the NetBIOS name is not registered on the WINS
server.

❒ The machine cannot communicate with devices that do not have the AutoNet
function. However, this machine can communicate with Macintosh comput-
ers running Mac OS X 10.2.3. or higher.
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Precautions

Please pay attention to the following when using the network interface board.
When configuration is necessary, follow the appropriate procedures below.

Connecting a Dial-Up Router to a Network

When using NetWare (file server)

If the NetWare file server and printer are on opposite sides of a router, packets
are sent back and forth continuously, possibly incurring communications charg-
es. Because packet transmission is a feature of NetWare, you need to change the
configuration of the router. If the network you are using does not allow you to
configure the router, configure the machine instead.

❖ Configuring the router
Filter packets so they do not pass over the dial-up router.

Note

❒ The MAC address of the filtering printer is printed on the printer configu-
ration page. For more information about printing a configuration page, see
Printer Reference.

❒ For more information about configuring the printer if the router cannot be
configured, see the following instructions.

Configuring the printer with NetWare

A Following the setup method described earlier in this manual, configure the
file server.

B Set the frame type for NetWare environment.

Reference

For more information about selecting a frame type, see the General Set-
tings Guide.

Configuring the printer without NetWare

AWhen not printing, the network interface board sends packets over the net-
work. Set NetWare to “inactive”.

Reference

For more information about selecting a protocol, see General Settings
Guide.



Precautions

117

4

When Using Network Utility

If the machine is connected to a network, observe the following points when set-
ting up the machine or changing settings:

For more details, see the operating instructions and Help for ScanRouter V2 Pro-
fessional and DeskTopBinder Lite/Professional.

❖ When a dial-up router is connected in a network environment
The settings for the delivery server to be connected must be made appropri-
ately for the machine with ScanRouter V2 Professional, Auto Document Link,
or DeskTopBinder Lite/Professional. In addition, set up connected devices
using the I/O settings of ScanRouter V2 Administration Utility.
If the network environment changes, make the necessary changes for the de-
livery server using the machine, the administration utility of client comput-
ers, Auto Document Link, and DeskTopBinder Lite/Professional. Also, set
the correct information for the connected devices using the I/O settings of
ScanRouter V2 Administration Utility.

Important

❒ If the machine is set up to connect to the delivery server via a dial-up rout-
er, the router will dial and go online whenever a connection to the delivery
server is made. Telephone charges may be incurred.

❖ When connected to a computer that uses dial-up access

• Do not install ScanRouter V2 Professional on a computer which uses dial-
up access.

• When using ScanRouter V2 Professional, DeskTopBinder Lite/Profession-
al, Auto Document Link, or a TWAIN driver on a computer with dial-up
access, a dial-up connection may be performed when connecting to the de-
livery server and other equipment, depending on the setup. If the compu-
ter is set up to connect to the Internet automatically, the confirmation
dialog box will not appear, and telephone charges may be incurred with-
out your being aware of it. To prevent unnecessary connections, the com-
puter should be set up so the confirmation dialog box always appears
before establishing a connection. Do not make unnecessary connections
when using the above listed software.
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NetWare Printing

Form feed

You should not configure form feed on NetWare. Form feed is controlled by the
printer driver on Windows. If NetWare form feed is configured, the printer
might not work properly. If you want to change form feed settings, always con-
figure them using Windows.

• Under Windows 95/98/Me, clear the [Form feed] check box on the [Printer Set-
tings] tab in the printer properties dialog box.

• Under Windows 2000/XP and Windows Server 2003, clear the [Form feed]
check box on the [NetWare Settings] tab in the printer properties dialog box.

• Under Windows NT 4.0, clear the [Form feed] check box on the [NetWare Set-
tings] tab in the printer properties dialog box.

Banner page

You should not configure a banner page on NetWare. If you want to change the
banner page setting, always configure it using Windows.

• Under Windows 95/98/Me, clear the [Enable banner] check box on the [Printer
Settings] tab in the printer properties dialog box.

• Under Windows 2000/XP and Windows Server 2003, clear the [Enable banner]
check box on the [NetWare Settings] tab in the printer properties dialog box.

• Under Windows NT 4.0, clear the [Enable banner] check box on the [NetWare
Settings] tab in the printer properties dialog box.

Printing after resetting the machine

After resetting the remote printer, the connection from the print server will be
cut off for about 30-40 seconds before re-connecting. Depending on the NetWare
specification, print jobs may be accepted, but they will not be printed during this
interval.

When using the machine as a remote printer, wait about two minutes after reset-
ting before attempting to print.
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When the optional IEEE 802.11b interface unit Is Installed

When using the wireless LAN interface on the network, note the following:

❖ When moving the machine
Detach the antennas when relocating the machine locally.
After moving the machine, reattach the antennas, ensuring that: 

• The antennas are positioned clear of obstacles.

• There is 40 to 60 mm between the antennas, so that they do not touch.

• The exposure glass cover and the Auto Document Feeder (ADF) do not
knock the antennas.

❖ If the network area provides poor radio environment
Where radio wave conditions are bad, the network may not function due to
interrupted or failed connections. When checking the wireless LAN signal
and the access point, follow the procedure below to improve the situation:

• Position the access point nearer to the machine.

• Clear the space between access point and machine of obstructions.

• Move radio wave generating appliances, such as microwaves, away from
the machine and access point.

Note

❒ For information about how to check radio wave status, see the General Set-
tings Guide.

❒ For more information about access point radio wave conditions, refer to the
access point manual.
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Information about Installed Applications

RSA® BSAFE

• This product includes RSA® BSAFE cryptographic or security protocol soft-
ware from RSA Security Inc.

• RSA is a registered trademark and BSAFE is a registered trademark of RSA
Security Inc. in the United States and/or other countries.

• RSA Security Inc. All rights reserved.
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Specifications

Interface 100BASE-TX, 10BASE-T, IEEE 802.11b

Frame type EthernetII, IEEE 802.2, IEEE 802.3, SNAP

Printer (LAN-Fax) TCP/IP

RSH

RCP

DIPRINT

FTP

IPP 

IPX/SPX (NetWare)

AppleTalk

Internet Fax TCP/IP

SMTP

POP

IMAP

Network Scanner TCP/IP

RSH

FTP

SMTP

POP

Document Server TCP/IP

FTP

HTTP

Management Function TCP/IP

RSH

RCP

FTP

SNMP

HTTP

TELNET (mshell)

NBT

DHCP

DNS

LDAP

SNMP v1/v2 MIB-II, PrinterMIB, HostResourceMIB, RicohPrivateMIB

SNMP v3 MIB-II, PrinterMIB, HostResourceMIB, RicohPrivateMIB, SNMP-
FRAMEWORK-MIB, SNMP-TARGET-MIB, SNMP-NOTIFICA-
TION-MIB, SNMP-USER-BASED-SM-MIB, SNMP-VIEW-
BASED-ACM-MIB
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To use IPP and SMB, use the SmartDeviceMonitor for Client port.

To use IPP under Windows XP, Windows Server 2003, use the Standard IPP
port. To use IPP under Windows 98, Windows 2000, Windows NT, use Smart-
DeviceMonitor for Client.

Appletalk can be used when the PostScript 3 module is installed.
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The product name of Windows® 95 is Microsoft® Windows 95.

The product name of Windows® 98 is Microsoft® Windows 98.

The product name of Windows® Me is Microsoft® Windows Millennium Edition (Windows Me).

The product names of Windows® 2000 are as follows:

Microsoft® Windows® 2000 Professional

Microsoft® Windows® 2000 Server

Microsoft® Windows® 2000 Advanced Server

The product names of Windows® XP are as follows:

Microsoft® Windows® XP Home Edition

Microsoft® Windows® XP Professional

The product names of Windows Server™ 2003 are as follows:

Microsoft® Windows Server™ 2003 Standard Edition

Microsoft® Windows Server™ 2003 Enterprise Edition

Microsoft® Windows Server™ 2003 Web Edition

The product names of Windows NT® 4.0 are as follows:

Microsoft® Windows NT® Workstation 4.0

Microsoft® Windows NT® Server 4.0

RSA Data Security, Inc. MD5 Message-Digest Algorithm

Copyright© 1991-2, RSA Data Security, Inc. Created 1991. All rights reserved.

License to copy and use this software is granted provided that it is identified as the “RSA Data Se-

curity, Inc. MD5 Message-Digest Algorithm” in all material mentioning or referencing this software

or this function.

License is also granted to make and use derivative works provided that such works are identified

as “derived from the RSA Data Security, Inc. MD5 Message-Digest Algorithm” in all material men-

tioning or referencing the derived work.

RSA Data Security, Inc. makes no representations concerning either the merchantability of this soft-

ware or the suitability of this software for any particular purpose. It is provided “as is” without ex-

press or implied warranty of any kind.

These notices must be retained in any copies of any part of this documentation and/or software.

Copyright © 2006
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